Before operating the unit, please read this Handbook and “Instruction Manual” thoroughly, and retain them for future reference.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
• For details on “Memory Stick Duo”, see page 122.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the battery pack
• Charge the battery pack (supplied) before using the camera for the first time.
• The battery pack can be charged even if it is not completely discharged. Also, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
• If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from your camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
• For details on the usable battery pack, see page 124.

Carl Zeiss lens
This camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast. The lens for this camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens
• The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.

Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
• Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
• Images may trail across on the LCD screen in a cold location. This is not a malfunction.
• Be careful not to bump the lens, and be careful not to apply force to it.

The pictures used in this Handbook
The photographs used as examples of pictures in this Handbook are reproduced images, and are not actual images shot using this camera.
Table of contents

Notes on using your camera .................................................................2
Basic techniques for better images ......................................................7
  Focus – Focusing on a subject successfully ...................................... 7
  Exposure – Adjusting the light intensity .......................................... 8
  Color – On the effects of lighting .................................................... 9
  Quality – On “image quality” and “image size” ..............................10
Identifying parts ..............................................................................11
Indicators on the screen .................................................................13
Changing the screen display .............................................................17
Using the internal memory ..............................................................18

Basic operations

Operating the touch panel ...............................................................19
Shooting images easily (Auto adjustment mode) ............................21
Viewing/deleting images .................................................................26

Advanced operations

Selecting the desired camera function .............................................28
  Setting the shooting mode .............................................................28
  Scene Selection: Selecting the best mode for scene ......................29
  MSET (Exposure Setting): Adjusting manually the shutter speed and aperture value .................................................................30
  (EV): Adjusting the exposure manually ........................................31
  (Focus): Changing the focus method ......................................... 32
Using the Album ............................................................................35
Using the Slide Show .....................................................................38
Painting on still images .................................................................41
Using the menu

Using menu items ........................................................................................................ 43
Menu items .................................................................................................................. 44

Shooting menu ................................................................................................................. 46
COLOR (Color Mode): Changing the vividness of the image or adding special effects
■ (Metering Mode): Selecting the metering mode
WB (White Bal): Adjusting the color tones
ISO: Selecting a luminous sensitivity
❖ (P.Quality): Selecting the still image quality
Mode (REC Mode): Selecting the continuous shooting method
BRK (Bracket Step): Shifting the EV in the [Exp Brktg] mode
 INTERVAL: Selecting the frame interval in the [Multi Burst] mode
△ (Flash Level): Adjusting the amount of flash light
❖ (Contrast): Adjusting the contrast of the image
❖ (Sharpness): Adjusting the sharpness of the image
❖ (Setup): Changing Setup items

Viewing menu .............................................................................................................. 54
❖ (Album): Displaying the still images in the Album
❖ (Exit Album): Finishing play back of images in the Album
❖ (Slide Show): Playing back a series of images
❖ (Paint): Painting on the still images
❖ (Delete): Deleting images
❖ (Volume): Adjusting the volume
❖ (Folder): Selecting a folder for viewing images
❖ (Protect): Preventing accidental erasure
DPOF: Adding a Print order mark
❖ (Print): Printing images using a printer
❖ (Resize): Changing the image size of a recorded image
❖ (Rotate): Rotating a still image
❖ (Divide): Cutting movies
❖ (Setup): Changing Setup items
❖ (Trimming): Recording an enlarged image
Using the Setup screen

Using Setup items ......................................................................................... 62

Camera 1 ........................................................................................................ 64
  AF Mode
  Digital Zoom

Camera 2 ........................................................................................................ 67
  Auto Review

Internal Memory .......................................................................................... 68
  Format

Memory Stick ................................................................................................. 69
  Format
  Create REC. Folder

Album ............................................................................................................. 72
  Write in Album
  Format

Setup 1 .......................................................................................................... 73
  Download Music
  Format Music

Setup 2 .......................................................................................................... 74
  LCD Backlight
  Beep

Setup 3 .......................................................................................................... 75
  File Number
  USB Connect

Setup 4 .......................................................................................................... 77
  Calibration
  Housing

Viewing images on a TV screen

Viewing images on a TV screen ...................................................................... 78
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using your computer</strong></td>
<td></td>
</tr>
<tr>
<td>Enjoying your Windows computer</td>
<td>80</td>
</tr>
<tr>
<td>Installing the software (supplied)</td>
<td>82</td>
</tr>
<tr>
<td>Copying images to your computer</td>
<td>83</td>
</tr>
<tr>
<td>Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)</td>
<td>90</td>
</tr>
<tr>
<td>Using the “Picture Motion Browser” (supplied)</td>
<td>91</td>
</tr>
<tr>
<td>Using the “Music Transfer” (supplied)</td>
<td>95</td>
</tr>
<tr>
<td>Using your Macintosh computer</td>
<td>96</td>
</tr>
<tr>
<td><strong>Printing still images</strong></td>
<td></td>
</tr>
<tr>
<td>How to print still images</td>
<td>98</td>
</tr>
<tr>
<td>Printing images directly using a PictBridge compliant printer</td>
<td>99</td>
</tr>
<tr>
<td>Printing at a shop</td>
<td>103</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td></td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>105</td>
</tr>
<tr>
<td>Warning indicators and messages</td>
<td>117</td>
</tr>
<tr>
<td><strong>Others</strong></td>
<td></td>
</tr>
<tr>
<td>To use your camera abroad — Power sources</td>
<td>121</td>
</tr>
<tr>
<td>On the “Memory Stick”</td>
<td>122</td>
</tr>
<tr>
<td>On the battery pack</td>
<td>124</td>
</tr>
<tr>
<td>On the battery charger</td>
<td>125</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td></td>
</tr>
<tr>
<td>Index</td>
<td>126</td>
</tr>
</tbody>
</table>
Basic techniques for better images

Focus Exposure Color Quality

This section describes the basics so you can enjoy your camera. It tells you how to use various camera functions by touching the buttons on the screen (page 19).

Focus Focusing on a subject successfully

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

Press the shutter button fully down suddenly. Press the shutter button halfway down. AE/AF lock indicator flashing ➔ lit/beeps Then press the shutter button fully down.

To shoot a still image difficult to focus on ➔ [Focus] (page 32) If the image looks blurred even after focusing, it may be because of camera shake. ➔ See “Hints for preventing blur” (as follows).

Hints for preventing blur

Hold the camera steadily, keeping your arms at your side. It is recommended to lean against a tree or a building nearby to steady yourself. Shooting with a 2-second delay self-timer, or using a tripod is also effective. Use the flash when you shoot under a low light condition.
Basic techniques for better images

**Exposure**  
*Adjusting the light intensity*

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

**Shutter speed** = Length of time the camera receives light

**Aperture** = Size of the opening allowing light to pass through

**ISO** = Recording sensitivity

The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**Manual exposure:**
Allows you to adjust the shutter speed and aperture value manually (page 30).

**EV:**
Allows you to adjust the exposure that has been determined by the camera (page 31).

**Metering Mode:**
Allows you to change the part of the subject to be measured to determine the exposure (page 47).

### Characteristics of “shutter speed”

- **Faster**
  - Moving objects appear stopped.

- **Slower**
  - Moving objects appear to flow.

### Characteristics of “aperture” (F value)

- **Open**
  - In-focus range narrows, both backward and forward.

- **Close**
  - In-focus range widens, both backward and forward.
Basic techniques for better images

Adjusting the ISO sensitivity
ISO is unit of measurement (sensitivity), estimating how much light an image pickup device (equivalent to photo films) receives. Even when the exposure is the same, images differ depending on the ISO sensitivity.
To adjust the ISO sensitivity, see page 49.

High ISO sensitivity
Records a bright image even when shooting in a dark location.
However, the image tends to become noisy.

Low ISO sensitivity
Records a smoother image.
However, when the exposure is insufficient, the image may become darker.

Color
On the effects of lighting
The apparent color of the subject is affected by the lighting conditions.

Example: The color of an image affected by light sources

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Blue-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode.
However, you can adjust color tones manually with [White Bal] (page 47).
A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

<table>
<thead>
<tr>
<th>#</th>
<th>Image size:</th>
<th>Pixels</th>
<th>Formula</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10M</td>
<td>3648 pixels × 2736 pixels = 9,980,928 pixels</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>VGA (E-Mail)</td>
<td>640 pixels × 480 pixels = 307,200 pixels</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Selecting the image size for use (page 25)

- **Many pixels** (Fine image quality and large file size)

  - Example: Printing in up to A3/A3 +* size

- **Few pixels** (Rough image quality but small file size)

  - Example: An attached image to be sent by e-mail

  * This is a size larger than A3 size. You can print images with a margin around the A3 size image.

Selecting the image quality (compression ratio) in combination (page 49)

You can select the compression ratio when digital images are saved. When you select a high compression ratio, the image lacks the fineness of detail, but has a smaller file size.
Identifying parts

See the pages in parentheses for details of operation.

1. **POWER button/lamp**
2. **Shutter button**
3. **Flash (23)**
4. **Self-timer lamp (23)/AF illuminator (66)**
5. **Microphone**
6. **Speaker**
7. **Lens**

1. For shooting: **Zoom (W/T) button (21)**
   For viewing: **[Wide/Tele] (Playback zoom) button/ [Index] button (26)**
2. **LCD screen (17)/touch panel (19)**
3. **Hook for wrist strap**
4. **Mode switch**
5. **(on-screen key) button**
   - Press this button longer to display the **(Setup) screen.**
6. **Battery/“Memory Stick Duo” cover**
7. **(Screen display switch) button (17)**
   - Press this button longer to change the brightness of the LCD backlight.
8. **Access lamp**
9. **“Memory Stick Duo” slot**
10. **Battery insertion slot**
11. **Battery eject lever**
Identifying parts

12 Tripod receptacle (bottom)
   - Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and may damage the camera.

13 Multi connector (bottom)
   When using an AC-LS5K AC Adaptor (not supplied)

   • You cannot charge the battery pack by connecting your camera to the AC-LS5K AC Adaptor. Use the battery charger to charge the battery pack.
Indicators on the screen

See the pages in parentheses for details of operation.

When shooting still images

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌚️</td>
<td>Battery remaining</td>
</tr>
<tr>
<td>●</td>
<td>AE/AF lock (22)</td>
</tr>
<tr>
<td>🎥 BRK</td>
<td>Recording mode (21, 50)</td>
</tr>
<tr>
<td>☀️ WB</td>
<td>White balance (47)</td>
</tr>
<tr>
<td>STBY REC</td>
<td>Standby/Recording a movie</td>
</tr>
<tr>
<td>ISO</td>
<td>Camera mode (Scene Selection) (29)</td>
</tr>
<tr>
<td>P M</td>
<td>Camera mode (Program/Manual) (28)</td>
</tr>
<tr>
<td>⚡️ SL</td>
<td>Flash mode (23)</td>
</tr>
</tbody>
</table>

When shooting movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥 STBY</td>
<td>00:00:00 [00:28:25]</td>
</tr>
<tr>
<td>🎥 B&amp;W</td>
<td></td>
</tr>
<tr>
<td>⚡️ WB</td>
<td>White balance (47)</td>
</tr>
<tr>
<td>STBY REC</td>
<td>Standby/Recording a movie</td>
</tr>
<tr>
<td>ISO</td>
<td>Camera mode (Scene Selection) (29)</td>
</tr>
<tr>
<td>P M</td>
<td>Camera mode (Program/Manual) (28)</td>
</tr>
<tr>
<td>⚡️ SL</td>
<td>Flash mode (23)</td>
</tr>
</tbody>
</table>

Display | Indication                        |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>⚡️</td>
<td>Flash charging</td>
</tr>
<tr>
<td>🔍</td>
<td>Zoom scaling (22, 64)</td>
</tr>
<tr>
<td>×1.3</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>Red-eye reduction (65)</td>
</tr>
<tr>
<td>P</td>
<td>Sharpness (53)</td>
</tr>
<tr>
<td>📀</td>
<td>Contrast (53)</td>
</tr>
<tr>
<td>🔍 ON</td>
<td>AF illuminator (66)</td>
</tr>
<tr>
<td>📀</td>
<td>Metering mode (47)</td>
</tr>
<tr>
<td>VIVID</td>
<td>NATURAL</td>
</tr>
<tr>
<td></td>
<td>SEPIA B&amp;W</td>
</tr>
<tr>
<td>📀</td>
<td>Color mode (46)</td>
</tr>
<tr>
<td>📀</td>
<td>Housing mode (77)</td>
</tr>
<tr>
<td>📀</td>
<td>Histogram (17, 32)</td>
</tr>
<tr>
<td>NR</td>
<td>NR slow shutter</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>Exposure Value (31)</td>
</tr>
<tr>
<td>F3.5</td>
<td>Aperture value (31)</td>
</tr>
<tr>
<td>125</td>
<td>Shutter speed (31)</td>
</tr>
</tbody>
</table>
### Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image size" /></td>
<td>Image size (25)</td>
</tr>
<tr>
<td><img src="image.png" alt="Recording folder" /></td>
<td>Recording folder (69)</td>
</tr>
<tr>
<td><img src="image.png" alt="Remaining internal memory capacity" /></td>
<td>Remaining internal memory capacity</td>
</tr>
<tr>
<td><img src="image.png" alt="Remaining “Memory Stick” capacity" /></td>
<td>Remaining “Memory Stick” capacity</td>
</tr>
<tr>
<td><img src="image.png" alt="Essay" /></td>
<td>Album (72)</td>
</tr>
<tr>
<td>![00:00:00 <a href="image.png">00:28:05</a></td>
<td>Recording time [maximum recordable time]</td>
</tr>
<tr>
<td><img src="image.png" alt="1/30”" /></td>
<td>Multi Burst interval (52)</td>
</tr>
<tr>
<td><img src="image.png" alt="400" /></td>
<td>Remaining number of recordable images</td>
</tr>
<tr>
<td><img src="image.png" alt="Self-timer" /></td>
<td>Self-timer (23)</td>
</tr>
<tr>
<td><img src="image.png" alt="C:32:00" /></td>
<td>Self-diagnosis display (117)</td>
</tr>
<tr>
<td><img src="image.png" alt="ISO400" /></td>
<td>ISO number (49)</td>
</tr>
<tr>
<td><img src="image.png" alt="±0.7EV" /></td>
<td>Bracket Step value (52)</td>
</tr>
</tbody>
</table>

### Vibration warning
- Indicates vibration may prevent you from shooting clear images due to insufficient lighting. Even if the vibration warning appears, you can still shoot images. However, we recommend using the flash for better lighting or using a tripod or other means to stabilize the camera (page 7).

### Low battery warning (117)
- Spot metering cross hair (47)

### AF range finder frame (33)

### Macro (24)
- AF mode (64)
- AF range finder frame indicator (33)
- Focus preset distance (33)
Indicators on the screen

When playing back still images

1. Battery remaining
2. Recording mode (21, 50)
3. Protect (55)
4. Print order (DPOF) mark (103)

When playing back movies

1. Zoom scaling (27)
2. Frame by frame playback (52)
3. Housing mode (77)

Display Indication
- Battery remaining
- Recording mode (21, 50)
- Protect (55)
- Print order (DPOF) mark (103)
- Playback
- Change folder (54)
  - This does not appear when using internal memory.
- Histogram (17, 32)
  - Appears when histogram display is disabled.
- Playback bar
- Control guide
## Indicators on the Screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image size" /></td>
<td>Image size (25)</td>
</tr>
<tr>
<td><img src="pictbridge.png" alt="PictBridge connecting" /></td>
<td>PictBridge connecting (99)</td>
</tr>
<tr>
<td><img src="recording.png" alt="Recording folder" /></td>
<td>Recording folder (69)</td>
</tr>
<tr>
<td><img src="playback.png" alt="Playback folder" /></td>
<td>Playback folder (54)</td>
</tr>
<tr>
<td><img src="memory.png" alt="Remaining internal memory capacity" /></td>
<td>Remaining internal memory capacity</td>
</tr>
<tr>
<td><img src="memorystick.png" alt="Remaining “Memory Stick” capacity" /></td>
<td>Remaining “Memory Stick” capacity</td>
</tr>
<tr>
<td><img src="album.png" alt="Album playback" /></td>
<td>Album playback (35)</td>
</tr>
<tr>
<td><img src="counter.png" alt="Counter" /></td>
<td>Number of images recorded in selected folder</td>
</tr>
</tbody>
</table>

**Notes:**
- Do not disconnect the cable for multi-use terminal while the icon is displayed.

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="exposure.png" alt="Exposure Value" /></td>
<td>Exposure Value (31)</td>
</tr>
<tr>
<td><img src="iso.png" alt="ISO number" /></td>
<td>ISO number (49)</td>
</tr>
<tr>
<td><img src="metering.png" alt="Metering mode" /></td>
<td>Metering mode (47)</td>
</tr>
<tr>
<td><img src="flash.png" alt="Flash" /></td>
<td>Flash</td>
</tr>
<tr>
<td><img src="whitebalance.png" alt="White balance" /></td>
<td>White balance (47)</td>
</tr>
<tr>
<td><img src="shutter.png" alt="Shutter speed" /></td>
<td>Shutter speed (31)</td>
</tr>
<tr>
<td><img src="aperture.png" alt="Aperture value" /></td>
<td>Aperture value (31)</td>
</tr>
<tr>
<td><img src="playbackimage.png" alt="Playback image" /></td>
<td>Playback image</td>
</tr>
<tr>
<td><img src="date.png" alt="Recorded date/time of the playback image" /></td>
<td>Recorded date/time of the playback image</td>
</tr>
<tr>
<td><img src="volume.png" alt="Volume" /></td>
<td>Volume</td>
</tr>
</tbody>
</table>
Changing the screen display

Each time you press the (Screen display switch) button, the display changes as follows.

- By pressing (Screen display switch) button longer, you can increase the LCD backlight.
- When you set the histogram display to on, image information is displayed during playback.
- The histogram does not appear in the following situations:
  While shooting
  – When the menu is displayed.
  – When recording movies
  During playback
  – When the menu is displayed.
  – In index mode
  – When you are using playback zoom.
  – When you are rotating still images.
  – During playback of movies
- A large difference in the histogram displayed when shooting and during playback may occur when:
  – The flash strobes.
  – The shutter speed is slow or high.
- The histogram may not appear for images recorded using other cameras.
Using the internal memory

The camera has approximately 25 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

- Movies with the image size set to [640(Fine)] cannot be recorded using the internal memory.

When a “Memory Stick Duo” is inserted

[Recording]: Images are recorded on the “Memory Stick Duo”.
[Playback]: Images on the “Memory Stick Duo” are played back.
[Menu, Setup, etc.]: Various functions can be performed on images on the “Memory Stick Duo”.

When there is no “Memory Stick Duo” inserted

[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Setup, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without error using one of the following methods.

To copy (back up) data on a “Memory Stick Duo”
Prepare a “Memory Stick Duo” with a capacity of 32 MB or more, then perform the procedure explained in [Copy] (page 70).

To copy (back up) data on a hard disk of your computer
Perform the procedure on pages 83 to 86 without a “Memory Stick Duo” inserted in the camera.

- You cannot copy image data on a “Memory Stick Duo” to the internal memory.
- By connecting the camera and a computer with a cable for multi-use terminal, you can copy data stored in the internal memory to a computer. However you cannot copy data on a computer to the internal memory.
1. Press \( \text{on-screen key} \) to display the touch panel buttons.
   - When the mode switch is set to \( \text{play} \), skip this operation.

2. Lightly touch the buttons on the screen with your finger.
   - Press \( \text{on-screen key} \) again to turn off the touch panel buttons.

On the touch panel buttons
- When the item you want to set is not on the screen, touch \( \text{up/down} \) to change the page.
- You can return to the previous screen by touching \( \text{next} \).

- To operate the touch panel, press it lightly with your finger or the supplied paint pen.
- Do not press the touch panel with any pointed object other than the supplied paint pen.
- Do not press against the LCD screen more than necessary.
Operating the touch panel

Dragging the screen
Still images can be changed or movies fast-forwarded or reversed by dragging the screen during playback. To use this function, press (on-screen key) to turn off the touch panel buttons.

Still images

- The image is changed when you remove your finger from the screen.

Movies

- Touch the screen to play back the movie.
- Drag the screen to the right to fast-forward and to the left to reverse the movie.
- Touch again during playback to pause.

Playback zoom

- Drag the screen up, down, left or right to slide the zoomed screen and display the hidden parts of the image.

- When the camera is connected to a television and images are being viewed on the television (page 78), the screen will not change to the previous or next image even if the camera screen is dragged.
- When viewing images taken in Multi Burst mode, touch the screen to pause the display. Drag the paused screen to the right to move one frame forward, and to the left to move one frame back.
Shooting images easily (Auto adjustment mode)

This section explains the method for starting to shoot images with the default settings.

1. **Select a mode with the mode switch.**
   - Still image (Auto adjustment mode): Select 📸.
   - Movie: Select 🎥.

2. **Hold the camera steadily, keeping your arms at your side.**

   Position the subject in the center of the focus frame. Do not cover the microphone with your finger.
3 Shoot with the shutter button.

When shooting images during 📷 displayed on the screen, those minimized copies of the original images can be saved in the Album (page 72).

**Still image (Auto adjustment mode):**
① Press and hold the shutter button halfway down to focus.
The ● (AE/AF lock) indicator (green) flashes, a beep sounds, the indicator stops flashing and remains lit.

② Press the shutter button fully down.

**Movie:**
Press the shutter button fully down.
To stop recording, press the shutter button fully down again.

---

If you shoot a still image of a subject that is difficult to focus on

- The shortest shooting distance is approx. 50 cm (19 3/4 inches). Shoot in the close-up (Macro) mode (page 24) when you shoot a subject closer than the shooting distance.
- When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flashing slowly and the beep does not sound. Recompose the shot and focus again.

It is difficult to focus when;
- It is dark and the subject is distant.
- The contrast between the subject and the background is poor.
- The subject is seen through glass.
- The subject is moving quickly.
- There is reflexive light or lustrous finish.
- The subject is backlit or there is a flashing light.

💡 Using the zoom

Press the zoom button.
- When the zoom scale exceeds 3x, the camera uses the Digital Zoom function.
  For details on the [Digital Zoom] settings and the image quality, see page 64.
- You cannot change the zoom scale while shooting a movie.
Shooting images easily (Auto adjustment mode)

Setting Flash mode/Self-timer/Macro recording/image size

Press  (on-screen key) to display the touch panel buttons.

Using the flash for still images

Using the self-timer

Shooting close-up (Macro)

Changing the image size

Flash (Selecting a flash mode for still images)

Touch  on the screen. Touch the desired item, then .

Auto: Flash Auto
- Strobes when there is insufficient light or backlight (default setting)

Forcedflash ( ): Flash forced on

Slow Synchro ( ): Flash forced on
- The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light.

No Flash ( ): Flash forced off
- The flash strobes twice. The first time is to adjust the light quantity.
- While charging the flash,  is displayed.

Using the self-timer

Touch  on the screen. Touch the desired item, then .

10 sec ( ): Setting the 10-second delay self-timer

2 sec ( ): Setting the 2-second delay self-timer

Off: Not using the self-timer
Shooting images easily (Auto adjustment mode)

Press the shutter button, the self-timer lamp flashes, and a beep sounds until the shutter operates.

![Self-timer lamp](image)

To cancel the self-timer shooting, press ¢ (on-screen key).
- If you use the 2-second delay self-timer, you may prevent blur.

🔧 Macro (Shooting close-up)

Touch 🔧 on the screen. Touch [On], then ➡.

On (🔧): Macro on (W side: Approx. 6 cm or farther (2 3/8 inches or farther), T side: Approx. 34 cm or farther (13 3/8 inches or farther))
Off: Macro off
- Setting the zoom all the way to the W side is recommended.
- The in-focus range becomes narrow, and the complete subject may not entirely be in focus.
- The Auto Focus speed drops.
Shooting images easily (Auto adjustment mode)

### Changing the image size

Touch on the screen. Touch the desired item, then .

For details on the image size, see page 10.
The default settings are marked with ✓.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Guidelines</th>
<th>No. of images</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ 10M (3648×2736)</td>
<td>For storing important images or printing A3/A3(+) size or fine A4 size images</td>
<td>Less</td>
<td>Fine</td>
</tr>
<tr>
<td>3:2 (3648×2432)</td>
<td>Match 3:2 Aspect Ratio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8M (3264×2448)</td>
<td>Up to A3/11×17” print</td>
<td>More</td>
<td></td>
</tr>
<tr>
<td>5M (2592×1944)</td>
<td>Up to A4/8×10” print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>Up to 13×18cm /5×7” print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2M (1632×1224)</td>
<td>Up to 10×15cm /4×6” print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td>For E-mail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>640×480</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:9(HDTV)(^3)</td>
<td>Display On 16:9 HDTV(^4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(1920×1080)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) This is a size larger than A3 size. You can print images with a margin around the A3 size image.
2) Images are recorded in 3:2 aspect ratio, same as photograph printing paper or postcards, etc.
3) Both edges of the image may be cut off when printing (page 113).
4) By using a Memory Stick slot or USB connection, you can enjoy images in higher quality.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>640(Fine)</td>
<td>Approx. 30</td>
<td>Display on TV (high quality)</td>
</tr>
<tr>
<td>✓ 640(Standard)</td>
<td>Approx. 17</td>
<td>Display on TV (standard)</td>
</tr>
<tr>
<td>160 (160×112)</td>
<td>Approx. 8</td>
<td>For E-mail</td>
</tr>
</tbody>
</table>

- The larger the image size, the higher the image quality.
- The more frames per second you played back, the smoother playback can be.
Viewing/deleting images

1 Select ◄ with the mode switch.

2 Select an image with ◄/►.
   Movie:
   Touch ►.
   Rewind/Fast forward: ◄/►
   (Return to normal playback: ◄)
   Volume: Touch [MENU] → [Volume] → +/- to adjust → [Exit].
   Stop playback: ■
   • Movies with the image size [160] are displayed a size smaller.

To delete images
Display the image you want to delete, then touch [MENU] → [Delete] → [Delete] → [OK].

To cancel the deletion
Touch [Exit] in ②, or [Cancel] in ③.
• Even when you delete an image, the minimized image recorded in the Album is still saved.
Viewing/deleting images

To view an enlarged image (playback zoom)
Press † while displaying a still image.
To undo the zoom, press ‡.

Adjust the portion: ▲/▼/◀/▶

• To store enlarged images: [Trimming] (page 61)

To view an index screen
Press ◀ (Index). Touch the image you want to view on the single-image screen.
To display the previous/next screen, touch ◀/▶.

If you press ◀ (Index) again, the 12-image index screen appears.

To delete images in index mode
① While an index screen is displayed, touch [MENU] → [Delete] → [Select].
② Touch the image you want to delete to display the 图画 (Delete) indicator.

Green selection frame

To cancel a selection
Touch the image you want to cancel deleting to turn off the图画 indicator on the image.

③ Touch [OK] → [OK].
• To delete all the images in the folder, touch [All in This Folder] in step ① instead of [Select].
Selecting the desired camera function

Setting the shooting mode

The modes can be changed with the mode switch.

Still image shooting modes
There are four shooting modes available for still images: auto, program, scene selection and manual. The default setting is [Auto].
To select shooting modes other than [Auto], see the following procedure.

1. Press 📷 (on-screen key).
2. Touch 📷 (Camera).
3. Touch the desired mode.

Auto: Auto adjustment mode
Allows easy shooting with the settings adjusted automatically.

Program: Program auto shooting mode
Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu. (Refer to page 44 for details on the functions available.)

Manual: Manual exposure shooting mode
Allows you to shoot with the exposure adjusted manually (both the shutter speed and the aperture value) (page 30). Also you can select various settings using the menu. (Refer to page 44 for details on the functions available.)

Scene Selection mode
Allows you to shoot with preset settings according to the scene (page 29).

Shooting movies
Playback/Edit
Mode switch
(on-screen key) button
Selecting the desired camera function

From this page, the available mode position for the menu items is shown as follows.

<table>
<thead>
<tr>
<th>Unavailable</th>
<th>Available</th>
</tr>
</thead>
</table>

Scene Selection: Selecting the best mode for scene

The following modes are predetermined to match the scene conditions.

- **High Sensitivity**
  - Allows you to shoot images without a flash under low light conditions, reducing blur.

- **Landscape**
  - Focuses only on a distant subject to shoot landscapes, etc.

- **Twilight**
  - Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.

- **Beach**
  - When shooting seaside or lakeside scenes, the blue of the water is clearly recorded.

- **Twilight Portrait**
  - Suitable for shooting portraits in dark places. Allows you to shoot sharp images of people in dark places without losing the dark atmosphere of the surroundings.

- **Snow**
  - When shooting snowy scenes or other places where the whole screen appears white, use this mode to prevent sunken colors and record clear images.

- **Soft Snap**
  - Allows you to shoot skin colors in brighter and warmer tones for more beautiful pictures. In addition, the soft focus effect creates a gentle atmosphere for portraits of people, flowers, etc.

- **Fireworks**
  - Allows you to record fireworks in all their splendor.

*The shutter speed becomes slower, so using a tripod is recommended.
Available functions with Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. Some functions are not available, depending on the Scene Selection mode.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>ISO</th>
<th>Macro</th>
<th>Flash</th>
<th>AF range finder</th>
<th>Focus preset</th>
<th>White Balance</th>
<th>Burst/Exposure Bracket/Multi Burst</th>
<th>Flash level</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍃</td>
<td>✓</td>
<td>❌</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>🌚</td>
<td>—</td>
<td>❌</td>
<td>✓</td>
<td>∞</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>✓</td>
<td>❌</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Auto/קבל</td>
<td>✓</td>
</tr>
<tr>
<td>🌧️</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🌞</td>
<td>—</td>
<td>❌</td>
<td>✓</td>
<td>∞</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🏼</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>🌞</td>
<td>—</td>
<td>❌</td>
<td>—</td>
<td>∞</td>
<td>☀️</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

**M**<sup>SET</sup> (Exposure Setting): Adjusting manually the shutter speed and aperture value

1. Press 📼 (on-screen key).
2. Touch 📼 (Camera) ➔ [Manual], then ➔ to set and return to the previous screen.

The camera becomes the manual exposure setting mode.

3. Touch **M**<sup>SET</sup>. 
Selecting the desired camera function

④ Adjust the shutter speed and the aperture value by touching ▲/▼.

When the zoom is set fully to the W side, you can select an aperture, F2.8, F4, or F8.
When the zoom is set fully to the T side, you can select an aperture, F5.4, F8, F16.
You can select a shutter speed from 1/1000 to 30 seconds.
The difference between the manual settings and proper exposure judged by the camera appears as an EV value (page 31) on the screen. 0EV indicates the value judged as the most suitable by the camera.

⑤ Shoot the image.

• The flash is set to $ (Forced flash) or ¶ (No Flash).
• At the following settings, the adjustment changes only the brightness, not the depth of field.
  – at F4 and F8 when the zoom is set fully to the W side
  – at F8 and F16 when the zoom is set fully to the T side
• Shutter speeds of one second or longer are indicated by [“], for example, 1”.
• When you set the shutter speed slower, using a tripod is recommended to prevent the effects of vibration.
• When the shutter speed drops below a certain speed in low light conditions, the NR slow shutter function activates automatically to reduce the picture noise and “NR” appears.
• If you select slow shutter speeds, it takes time to process the data.

((EV): Adjusting the exposure manually

① Press (on-screen key).
② Set (Camera) to a setting other than [Auto] and [Manual], then touch ➔:

③ Touch (EV).
④ Select a value by touching ▲/▼.

Toward +: Brightens an image.
0EV: The exposure is determined automatically by the camera.
Toward -: Darkens an image.
Selecting the desired camera function

- For details on the exposure, see page 8.
- The compensation value can be set in 1/3EV increments.
- If a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.

Adjusting EV (Exposure Value) by displaying a histogram

A histogram is a graph showing the brightness of an image. Press [ ] (Screen display switch) repeatedly to display the histogram inside the screen. The graph display indicates a bright image when skewed to the right side, and a dark image when skewed to the left side. Select [Program] or one of the scene selection modes for (Camera) and adjust EV while checking the exposure with the histogram.

A Number of pixels
B Brightness

- The histogram also appears in the following cases, but you cannot adjust the exposure.
  - When (Camera) is set to [Auto] or [Manual]
  - When playing back a single image

(Focus): Changing the focus method

You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

1. Press (on-screen key).
2. Set (Camera) to a setting other than [Auto], then touch .
3. Touch (Focus).
4. Touch the desired option.
Selecting the desired camera function

The default settings are marked with ✔.

| ✔ Multi AF (Multipoint AF) (Still image) (Movie) | Focuses automatically on a subject in all ranges of the finder frame (default setting).
| | ✔ This mode is useful when the subject is not in the center of the frame. |
| Center AF | Focuses automatically on a subject in the center of the finder frame.
| | ✔ Using this with the AF lock function lets you shoot in the desired image composition. |
| Spot AF (Flexible Spot AF) | By moving the AF range finder frame to wherever you like on the screen, you can focus on an extremely small subject or a narrow area.
| | ✔ To set the Flexible Spot AF, see page 34. |
| | ✔ This is useful when you shoot using a tripod and the subject is out of the center area. |
| | ✔ When shooting a moving subject, take care to hold the camera steadily so that the subject does not deviate from the range finder frame. |
| ∞ (unlimited distance) | Focuses on the subject using a previously set distance to the subject. (Focus preset)
| 7.0m | ✔ When shooting a subject through a net or through window glass, it is difficult to get the proper focus in auto focus mode. In these cases, use of the focus preset is convenient. |
| 3.0m |
| 1.0m |
| 0.5m |
Selecting the desired camera function

- AF stands for Auto Focus.
- Distance setting information in the focus preset is approximate. If you point the lens up or down, the error increases.
- When you are shooting movies, [Multi AF] is recommended as the AF works even with a certain amount of vibration.
- When you use Digital Zoom or AF Illuminator, priority AF movement is given to subjects in or near the center of the frame. In this case, the  or indicator flashes and the AF range finder frame is not displayed.
- Some options are not available depending on the Scene mode (page 30).

How to use the [Spot AF]

1. Set (Camera) to a setting other than [Auto], then touch .
2. Touch (Focus) → [Spot AF].
3. Press (on-screen key) to turn off the menu.
4. Touch where you want to focus the shot.
Using the Album

When shooting images during 📈 displayed on the screen, those minimized copies of the original images can be saved in the Album (page 72). Even if images are deleted from the internal memory or the “Memory Stick Duo”, you can still view the minimized images stored in the Album.

Still images are recorded in the Album in [VGA(E-Mail)] ([1M] for Multi Burst images) image size and [Standard] picture quality. The Album can store a maximum of 500 images.

If you turn the power off or move the mode switch during Album playback, Album playback stops.

To play back images stored in the Album

1. Set the mode switch to 📈.
2. Touch [MENU] → [Album].
   Images in the Album will be organized by the shooting date. Each unit of this group to be displayed on the index screen is called “This date.”

   - Recording year
   - Recording month
   - Recording day

3. Select the “This date” you want to display with ←/→, then touch it.
   All images recorded in “This date” are displayed on the index screen.

   - Recording year/month/day
   - Recording time

If you want to return to the previous index screen, press (Index).
Using the Album

④ Touch the image. (If the image you want is not on the screen, touch  /  until it appears on the screen.)
The selected image appears.

- To return to the index screen in “This date,” press  (Index).

To delete images in the album

To delete images on the single-image screen
① Display the image you want to delete, then touch [MENU] to display the menu.
② Touch [Delete] → [Delete] → [OK].

To delete images on the index screen
① Touch [MENU] on the screen in step ③ of “To play back images stored in the Album” to display the menu. (You cannot delete the images in “This date” in step ② of “To play back images stored in the Album”.)
② Touch [Delete] → [Select].
③ Touch the image you want to delete to mark it with the  (Delete) indicator.
④ Touch [OK] → [OK].
- To delete all the images in “This date,” touch [All in this date] in step ②.
Using the Album

Image data in the Album

- When the Album becomes full, your old image data gets deleted automatically. Protect the data you do not want to be deleted (page 55).
- When the capacity of Album is full with protected images, ⚠️⚠️ blinks. Although you can record images in the internal memory or the “Memory Stick Duo”, you cannot record the images in the Album. If you remove the protection of unwanted images, you can record the image data in the Album.
- To create a backup for your image data in the Album, perform the procedure explained in [Copy] (page 70).
- You cannot transfer the image data in the Album directly to a computer. Perform the procedure explained in [Copy] (page 70). Copy the desired image data on the “Memory Stick Duo”, then transfer it to a computer.
- Data on a “Memory Stick Duo” or computer cannot be copied to the Album.
- Even if you protect the images recorded in the internal memory or the “Memory Stick Duo”, those same minimized images in the Album are not protected. Also, even if the minimized images in the Album are protected, those same images in the internal memory or the “Memory Stick Duo” are not protected (page 55).
- If you trim or resize images in the internal memory or the “Memory Stick Duo”, those same images in the Album are not affected.
- You cannot use the following functions on the images saved in the Album:
  - Paint
  - Marking the print order (DPOF)
  - Print
  - Resize
  - Trimming
Using the Slide Show

You can view a series of images with effect and accompanied by music (Slide Show).

To adjust the volume of the music
Press \( \text{(on-screen key)} \) during playback, then touch \(+/-\) to adjust the volume. Otherwise, touch [Volume] in the [MENU] and adjust the volume before you begin the slide show.

To pause the slide show
Touch the screen. Touch [Continue] to resume. The slide show resumes from the image which was paused, however, the music starts again from the beginning.

To display the previous/next image
Touch \("/\) during pause.

To end the slide show
Touch [Exit] during pause.

• You cannot play back a slide show while connected to PictBridge.

To set the slide show options
You can set how to perform the slide show.
1. Touch [MENU] \( \rightarrow \) [Slide Show].
2. Touch the menu item you want to set.
3. Touch the desired setting, then \( \Rightarrow \).
Using the Slide Show

You can set the following options. The default settings are marked with ✔.

**Effects**

<table>
<thead>
<tr>
<th>Effects</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>A simple slide show suitable for a wide range of scenes.</td>
</tr>
<tr>
<td>Nostalgic</td>
<td>A moody slide show reproducing the atmosphere of a movie scene.</td>
</tr>
<tr>
<td>✔ Stylish</td>
<td>A stylish slide show proceeding at a middle tempo.</td>
</tr>
<tr>
<td>Active</td>
<td>A high-tempo slide show suitable for active scenes.</td>
</tr>
<tr>
<td>Normal</td>
<td>A basic slide show switching images at a predetermined interval.</td>
</tr>
</tbody>
</table>

- With [Simple], [Nostalgic], [Stylish], and [Active] effects,
  - only still images are displayed.
  - only the first image is displayed when the images were taken using Multi Burst mode.
- When set to [Normal], [Music] is set to [Off] as the default setting. The sound of movies will be heard.

**Music**

Music is prepared for each effect.

<table>
<thead>
<tr>
<th>Music</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music1</td>
<td>The default setting for a [Simple] slide show.</td>
</tr>
<tr>
<td>Music2</td>
<td>The default setting for a [Nostalgic] slide show.</td>
</tr>
<tr>
<td>✔ Music3</td>
<td>The default setting for a [Stylish] slide show.</td>
</tr>
<tr>
<td>Music4</td>
<td>The default setting for an [Active] slide show.</td>
</tr>
<tr>
<td>Off</td>
<td>Setting for a [Normal] slide show. No music.</td>
</tr>
</tbody>
</table>

**Image**

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Folder (This Date)</td>
<td>Plays back all images in the selected folder (for Album playback, images in [This Date]).</td>
</tr>
<tr>
<td>All</td>
<td>Plays back all images stored on the “Memory Stick Duo” or the Album.</td>
</tr>
</tbody>
</table>

- This option is fixed to [All] right after the Album playback is selected (when you try to set the slide show options on the index screen in the unit of “This date”). To select [This Date], first select the date of the Album you want to play back.
Using the Slide Show

<table>
<thead>
<tr>
<th>Repeat</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
<td>Plays back images in a continuous loop.</td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slide show ends.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interval</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ 3 sec</td>
<td>Sets the slide show interval for a [Normal] slide show.</td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>

Start
Starts the slide show.

💡 To add/change Music files
You can transfer the desired music (Music file) from your CDs or MP3 files to the camera to play back during a slide show. You can transfer the music by [Download Music] in the (Setup) menu using the supplied “Music Transfer” software installed on a computer. For details, see page 95.

- You can record up to four pieces of music on the camera (the four preset pieces (Music 1 – 4) can be changed with the desired pieces).
- The maximum length of each Music file for music playback on the camera is 180 seconds.
- If you cannot play back a Music file due to damage to the file or other malfunctions, execute [Format Music] (page 73) and transfer the music again.
Painting on still images

You can paint or put stamps on still images and save them separately. Use the paint pen (supplied) for this operation.

- You cannot paint or put stamps on Multi Burst images, movies, or images in the Album.
- When viewing recorded images on a TV (page 78), you cannot paint the images.

To display the painting

1. Set the mode switch to [ ].
2. Touch [MENU] → [Paint].

   1. (pen) button
   2. (stamp) button
   3. (eraser) button
   4. Thickness select button/Stamp select button
   5. Color select button
   6. (revert) button
   7. (clear all) button
   8. (Internal memory save) button/
      (“Memory Stick” save) button
   9. Exit) button

To paint characters or graphics

1. Touch .
2. Select the line thickness.
   Touch the thickness select button, the desired thickness, then .
3. Paint characters or graphics.

To stamp

1. Touch .
2. Select a stamp.
   Touch the stamp select button, the desired stamp, then .
3. Put stamps on the image.
Painting on still images

To change the color of the line or stamp
Touch the color select button, a desired color, then ➜.  
• The selected color is applied to both the line and stamp.

To make corrections
Touch ◊, then rub the part you want to erase using the paint pen. Otherwise, touch ◊ to revert to the previous state (if you touch ◊ again, it returns to the latest state).  
• You can select the thickness of the eraser in the same way as you do for the pen, using the thickness select button. The selected thickness is applied to both the line and eraser.

Erasing all painting
1 Touch ◊.  
   “Clear All” appears.  
2 Touch [OK].  
   All painting will disappear from the image.  
Touch [Cancel] to cancel the operation.

To save the painting
1 Touch ◊ (or ◊).  
   “Save” appears.  
2 Touch [OK].  
   The painted image is recorded in the recording folder as the newest file.  
Touch [Cancel] to cancel the operation.  
• The image is saved in [VGA(E-Mail)] image size and [Fine] picture quality.

To exit paint mode
1 Touch ✗.  
   “Exit” appears.  
2 Touch [OK].  
   Touch [Cancel] to cancel the operation.  
• If you touch ✗ before saving the image, the painting is abandoned. Be sure to save the painting by touching ◊/◊ if you intend to save it.
1 **Turn on the power and set the mode switch.**

Different items are available depending on the position of the mode switch and the (Camera) menu settings.

2 **Press (on-screen key) to display the touch panel buttons.**

   - When the mode switch is set to , skip this operation.

3 **Touch [MENU] to display the menu.**

4 **Touch the item you want to set.**

5 **Touch the setting.**

6 **Press (on-screen key) to turn off the menu.**

   - If there is an item that is not displayed, an ▲▼ mark appears on the edges of the location where menu items usually appear. To display an item that is not displayed, touch ▲▼.
   - You cannot set items that are grayed out.
The available menu items vary depending on the mode switch position. Only the available items are displayed on the screen.

### Mode switch position:

<table>
<thead>
<tr>
<th>Mode switch position:</th>
<th>Auto</th>
<th>Program</th>
<th>Manual</th>
<th>Scene</th>
<th>(✓ : available)</th>
</tr>
</thead>
</table>

### Menu for shooting (page 46)

<table>
<thead>
<tr>
<th>COLOR (Color Mode)</th>
<th>—</th>
<th>✓</th>
<th>✓</th>
<th>—</th>
<th>✓</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Metering Mode)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>WB (White Bal)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(P.Quality)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Mode (REC Mode)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>BRK (Bracket Step)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓*</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Interval)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓*</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Flash Level)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓*</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Contrast)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Sharpness)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Setup)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
</tbody>
</table>

*The operation is limited according to the Scene mode (page 30).
Menu items

For details on the operation page 43

Mode switch position:

<table>
<thead>
<tr>
<th></th>
<th>Auto</th>
<th>Program</th>
<th>Manual</th>
<th>Scene</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Camera</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Movie</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| (✓ : available) |

**Menu for viewing** (page 54)

<table>
<thead>
<tr>
<th>(Album)</th>
<th>(Exit Album)</th>
<th>(Slide Show)</th>
<th>(Paint)</th>
<th>(Delete)</th>
<th>(Volume)</th>
<th>(Folder)</th>
<th>(Protect)</th>
<th>DPOF</th>
<th>(Print)</th>
<th>(Resize)</th>
<th>(Rotate)</th>
<th>(Divide)</th>
<th>(Setup)</th>
<th>(Trimming)*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Available only for playback zoom.
COLOR (Color Mode): Changing the vividness of the image or adding special effects

You can change the vividness of the image, accompanied by effects.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Normal</td>
<td><img src="image-url" alt="Normal Image" /></td>
</tr>
<tr>
<td>Vivid (VIVID)</td>
<td>Sets the image to bright and deep color.</td>
</tr>
<tr>
<td>Natural (NATURAL)</td>
<td>Sets the image to quiet color.</td>
</tr>
<tr>
<td>Sepia (SEPIA)</td>
<td>Sets the image to sepia color.</td>
</tr>
<tr>
<td>B&amp;W (B &amp; W)</td>
<td>Sets the image to monochromatic color.</td>
</tr>
</tbody>
</table>

- You can select only [B&W] and [Sepia] when shooting movies.
- When [Multi Burst] is selected, the color mode is set to [Normal].
Selects the metering mode that sets which part of the subject to measure to determine the exposure.

- **Multi (Multi-pattern metering)**
  - Divides into multiple regions and measures each region. The camera determines a well-balanced exposure.

- **Center (Center-weighted metering)**
  - Measures the center of the image, and determines the exposure based on the brightness of the subject there.

- **Spot (Spot metering)**
  - Measures only a part of the subject.
  - This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.

For details on the exposure, see page 8.

When using spot metering or center-weighted metering, setting (Focus) to [Center AF] is recommended to focus on the metering position (page 32).

Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

- **Auto**
  - Adjusts the White Balance automatically.

- **Daylight (☀️)**
  - Adjusts for outdoors, shooting night scenes, neon signs, fireworks, or sunrise, or conditions before and after sundown.

- **Cloudy (☁️)**
  - Adjusts for a cloudy sky.
<table>
<thead>
<tr>
<th>Fluorescent (_suffix)</th>
<th>Adjusts for fluorescent lighting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incandescent (_suffix)</td>
<td>Adjusts for places where the lighting conditions change quickly such as at a party hall, or under bright lighting such as at photography studios.</td>
</tr>
</tbody>
</table>
| Flash (_suffix WB) | Adjusts for the flash conditions.  
• You cannot select this item when shooting movies. |

- For details on the white balance, see page 9.
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent] (_suffix).
- Except in [Flash] (_suffix WB) modes, [WB] is set to [Auto] when the flash strobes.
- Some options are not available depending on the Scene mode (page 30).
ISO: Selecting a luminous sensitivity

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>400</td>
</tr>
<tr>
<td></td>
<td>800</td>
</tr>
<tr>
<td></td>
<td>1600</td>
</tr>
</tbody>
</table>

Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.

- For details on the ISO sensitivity, see page 9.
- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [Auto] in the Scene mode.
- When shooting under brighter conditions, the camera automatically increases its tone reproduction and helps prevent images to become whitish (excluding when [ISO] is set to [100]).

(P.Quality): Selecting the still image quality

Selects the still image quality.

<table>
<thead>
<tr>
<th>✓</th>
<th>Fine (FINE)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Records with high quality (low compression).</td>
</tr>
<tr>
<td></td>
<td>• When (Camera) is set to [Auto], (P.Quality) is set to [Fine].</td>
</tr>
<tr>
<td></td>
<td>Standard (STD)</td>
</tr>
<tr>
<td></td>
<td>Records with standard quality (high compression).</td>
</tr>
</tbody>
</table>
Shooting menu

For details on the operation page 43

Mode (REC Mode): Selecting the continuous shooting method

Selects whether the camera performs continuous shooting or not when you press the shutter button.

<table>
<thead>
<tr>
<th>Normal</th>
<th>Does not shoot continuously.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Burst ( )</strong></td>
<td>Records the maximum number of images in succession (refer to the following table) when you press and hold down the shutter button.</td>
</tr>
<tr>
<td></td>
<td>• When “Recording” disappears, you can shoot the next image.</td>
</tr>
<tr>
<td></td>
<td>• The flash is set to (No Flash).</td>
</tr>
<tr>
<td><strong>Exp Brktg (BRK)</strong></td>
<td>Records a series of three images with the exposure values automatically shifted.</td>
</tr>
<tr>
<td></td>
<td>• When you cannot decide the correct exposure, shoot in the Exp Brktg mode, shifting the exposure value. You can select the image with the best exposure afterward.</td>
</tr>
<tr>
<td></td>
<td>• The flash is set to (No Flash).</td>
</tr>
<tr>
<td><strong>Multi Burst ( )</strong></td>
<td>Records 16 frames in succession as a still image file when you press the shutter button.</td>
</tr>
<tr>
<td></td>
<td>• The image size of images shot in the Multi Burst mode is 1M.</td>
</tr>
<tr>
<td></td>
<td>• This is convenient for checking your form in sports, for example.</td>
</tr>
<tr>
<td></td>
<td>• You can select the Multi Burst shutter interval in [Interval] mode (page 52).</td>
</tr>
<tr>
<td></td>
<td>• The images are displayed in sequence on the camera screen.</td>
</tr>
<tr>
<td></td>
<td>• The image is printed as a single image with 16 frames.</td>
</tr>
<tr>
<td></td>
<td>• The flash is set to (No Flash).</td>
</tr>
</tbody>
</table>
On the [Burst]
- When recording with the self timer, a series of a maximum of five images is recorded.
- The recording interval is approximately 1.2 seconds.
- When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
- You may not be able to shoot images in the Burst mode depending on the Scene mode (page 30).

The maximum number of continuous shots
Figures in ( ) are when [Write in Album] is set to [Off] in the
(Album).

(Units: images)

<table>
<thead>
<tr>
<th>Size</th>
<th>Quality</th>
<th>Fine</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>10M</td>
<td></td>
<td>3 (3)</td>
<td>4 (5)</td>
</tr>
<tr>
<td>3:2</td>
<td></td>
<td>3 (3)</td>
<td>4 (5)</td>
</tr>
<tr>
<td>8M</td>
<td></td>
<td>3 (3)</td>
<td>5 (5)</td>
</tr>
<tr>
<td>5M</td>
<td></td>
<td>4 (5)</td>
<td>8 (8)</td>
</tr>
<tr>
<td>3M</td>
<td></td>
<td>7 (7)</td>
<td>11 (12)</td>
</tr>
<tr>
<td>2M</td>
<td></td>
<td>10 (11)</td>
<td>15 (15)</td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td></td>
<td>15 (15)</td>
<td>15 (15)</td>
</tr>
<tr>
<td>16:9(HDTV)</td>
<td></td>
<td>10 (11)</td>
<td>15 (15)</td>
</tr>
</tbody>
</table>

On the [Exp Brktg]
- The focus and white balance are adjusted for the first image, and these settings are also used for the other images.
- When the exposure is manually adjusted (page 31), the exposure is shifted based on the adjusted brightness.
- The recording interval is approximately 1.0 second.
- If the subject is too bright or too dark, you may be unable to shoot properly with the selected bracket step value.
- You may not be able to shoot images in the Exposure Bracket mode depending on the Scene mode (page 30).
On the [Multi Burst]

- You can successively play back images shot in the Multi Burst mode using the following procedures:
  - To pause/resume: Touch ○.
  - To play back frame-by-frame: Touch ◀/▶ in pause mode. Touch ▶ to resume playback in series.
- You cannot use the following functions in the Multi Burst mode:
  - Smart zoom
  - Dividing a series of images shot in the Multi Burst mode
  - Extracting or deleting a frame in a series of images shot in the Multi Burst mode
  - Setting the frame interval to a mode other than [1/30] when (Camera) is set to [Auto]
- When playing back a series of images shot in the Multi Burst mode using a computer or a camera not equipped with the Multi Burst function, the image is displayed as a single image with 16 frames.
- You may not be able to shoot images in the Multi Burst mode depending on the Scene mode (page 30).

### BRK (Bracket Step): Shifting the EV in the [Exp Brktg] mode

Records a series of three images with the exposure values automatically shifted.

| ±1.0EV | Shifts the exposure value by plus or minus 1.0EV. |
| ±0.7EV | Shifts the exposure value by plus or minus 0.7EV. |
| ±0.3EV | Shifts the exposure value by plus or minus 0.3EV. |

- BRK (Bracket Step) is not displayed in some Scene modes.

### (Interval): Selecting the frame interval in the [Multi Burst] mode

Selects the frame interval in the [Multi Burst] mode (page 50).

| 1/30 (1/30") | Select [Multi Burst] in [Mode] first, then set the desired frame interval in [Interval]. When you select a function other than [Multi Burst], this function is unavailable. |
| 1/15 (1/15") |
| 1/7.5 (1/7.5") |

- (Interval) is not displayed in some Scene modes.

### ± (Flash Level): Adjusting the amount of flash light

Adjusts the amount of flash light.

| + (+) | Toward +: Makes the flash level higher. |
| Normal |
| − (−) | Toward −: Makes the flash level lower. |

- To change flash mode, see page 23.
- You may not be able to set the Flash Level depending on the Scene mode (page 30).
Shooting menu

For details on the operation page 43

(Contrast): Adjusting the contrast of the image

Adjusts the contrast of the image.

<table>
<thead>
<tr>
<th>+ ( )</th>
<th>Toward +: Enhances the contrast.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔   Normal</td>
<td></td>
</tr>
<tr>
<td>− ( )</td>
<td>Toward -: Reduces the contrast.</td>
</tr>
</tbody>
</table>

(Sharpness): Adjusting the sharpness of the image

Adjusts the sharpness of the image.

<table>
<thead>
<tr>
<th>+ ( )</th>
<th>Toward +: Sharpens the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔   Normal</td>
<td></td>
</tr>
<tr>
<td>− ( )</td>
<td>Toward -: Softens the image.</td>
</tr>
</tbody>
</table>

(Setup): Changing Setup items

See page 62.
Viewing menu

From this page, the available media ("Memory Stick Duo", internal memory and Album) for the menu items are shown as follows.

Displays the still images in the Album.
See page 35.

Finishes playing back of images in the Album.

Plays back recorded images in order with effect and accompanied by music.
See page 38.

Paints characters or graphics on the still images.
See page 41.

Deletes unnecessary images.
See page 26.

Adjusts the volume.
See pages 26, 38.

Selects the folder containing the image you want to play back when using the camera with "Memory Stick Duo".

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the selection.</td>
</tr>
</tbody>
</table>
Using the menu

Viewing menu

For details on the operation page 43

1. Select the desired folder with ◀/▶.

![Select Folder]

2. Touch [OK].

On the folder

The camera stores images in a specified folder of a “Memory Stick Duo”. You can change the folder or create a new one.

- To create a new folder → [Create REC. Folder] (page 69)
- To change the folder for recording images → [Change REC. Folder] (page 70)
- When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.
  - : Moves to the previous folder.
  - : Moves to the next folder.
  - : Moves to either the previous or next folders.

Protect (Protect): Preventing accidental erasure

Protects images against accidental erasure. You can prevent the images in the Album from being deleted automatically by protecting them in the Album.

<table>
<thead>
<tr>
<th>Protect (Protect)</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Exits the Protection function.</td>
</tr>
</tbody>
</table>

To protect images in single-image mode

1. Display the image you want to protect.
2. Touch [MENU] to display the menu.
3. Touch ▲/▼ to display Protect (Protect), then touch Protect (Protect).
4. Touch [Protect].
   The image is protected and the Protect (protect) indicator appears on the image.

5. To protect other images, display the desired image with ◀/▶, then touch [Protect].
Viewing menu

For details on the operation page 43

To protect images in index mode

1. Press (Index) to display the index screen.
2. Touch [MENU] to display the menu.
3. Touch [Protect] → [Select].
4. Touch the image you want to protect.
   A green (protect) indicator appears on the selected image.

5. Repeat step 4 to protect other images.
6. Touch [OK] → [OK].
   • To protect all images in the folder, touch [Protect] → [All In This Folder] → [On].

To cancel the protection

In single-image mode
Display the image from which you want to remove protection, touch [MENU] → [Protect] → [Protect].

In index mode

1. Select the image from which you want to remove protection in step 4 of “To protect images in index mode.”
2. Repeat the operation above for all images to be unprotected.
3. Touch [OK] → [OK].

To cancel protection of all images in the folder
Select [All In This Folder] in step 3 of “To protect images in index mode,” then touch [Off].

• Note that formatting the internal memory or “Memory Stick Duo” erases all the data stored on the recording media, even if the images are protected, and these images cannot be restored.
• It may take some time to protect an image.

DPOF: Adding a Print order mark

Adds a (Print order) mark to images you want to print (page 103).

(Print): Printing images using a printer

See page 99.
You can change the image size of a recorded image (Resize), and save it as a new file. The original image is retained even after resizing.

1. Display the image you want to resize.
2. Touch [MENU] to display the menu.
3. Touch ▲/▼ to display Resize (Resize), then touch it.
4. Touch the desired size, then [OK].

The resized image is recorded in the recording folder as the newest file.

- For details on Image Size, see page 10.
- You cannot change the size of movies, Multi Burst images, or images in the Album.
- When you change from a small size to a large size, the image quality deteriorates.
- You cannot resize to an image size of 3:2 or 16:9.
- When you resize a 3:2 or 16:9 image, the upper and lower black portions will be displayed on the image.
① Display the image to be rotated.
② Touch [MENU] to display the menu.
③ Touch ▲▼ to display Rot (Rotate), then touch it.
④ Touch ← → to rotate the image.
⑤ Touch [OK].

- You cannot rotate protected images, movies, or Multi Burst images.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.

(Divide): Cutting movies

Flow of the movie ➔

Cuts movies, or deletes unnecessary scenes of movies. This is a recommended function to use when the internal memory or “Memory Stick Duo” capacity is insufficient, or when you attach movies to your e-mail messages.

- Note that the original movie is deleted and that number is skipped. Also note that you cannot restore files once you cut them.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels division.</td>
</tr>
</tbody>
</table>
Example: Cutting a movie numbered 101_0002

This section describes an example of dividing a movie numbered 101_0002 and deleting it in the following file configuration.

1 Cutting scene A.

2 Cutting scene B.

3 Deleting scenes A and B if they are unnecessary.

4 Only the desired scenes remain.
Procedure

① Display the movie to be divided.
② Touch [MENU] to display the menu.
③ Touch ▲▼ to display ✿ (Divide), then touch it.
④ Touch [OK].
   The playback of the movie starts.
⑤ Touch ■ at the desired cutting point.
   • When you want to adjust the cutting point, touch ◀▶ (frame rewind/forward).
   • If you want to change the cutting point, touch ▶. The playback of the movie starts again.
⑥ Touch [OK] → [OK].
   The movie is cut.
   • The cut movies are assigned new numbers, and then recorded as the newest files in the selected recording folder.
   • You cannot cut the following kinds of images.
     – Still images
     – Movies not long enough to cut (shorter than about two seconds)
     – Protected movies (page 55)

(Setup): Changing Setup items

See page 62.
Viewing menu

For details on the operation page 43

(Trimming): Recording an enlarged image

Records an enlarged image (page 27) as a new file.

<table>
<thead>
<tr>
<th>Image Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10M</td>
<td>For details on guidelines for selecting the image size, see page 25.</td>
</tr>
<tr>
<td>8M</td>
<td></td>
</tr>
<tr>
<td>5M</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
</tbody>
</table>

1. Touch [MENU] during playback zoom to display the menu.
2. Touch [Trimming].
3. Touch the image size.
4. Touch [OK].
   The image is recorded, and the original image is displayed again.

- The trimmed image is recorded as the newest file in the selected recording folder, and the original image is retained.
- The quality of trimmed images may deteriorate.
- You cannot trim to an image size of 3:2 or 16:9 aspect ratio.
- You cannot trim images in the Album.
You can change the default settings using the (Setup) screen.

1 Press (on-screen key) to display the touch panel buttons.
   • When the mode switch is set to <, skip this operation.

2 Touch [MENU] to display the menu.

3 Touch ▼ to display (Setup), then touch it.

4 Touch ▲/▼ to display the item you want to set, then touch it.

5 Touch the option you want to set.
   The selected option turns blue and is set.

To turn off the (Setup) screen, press (on-screen key).
To return to the menu from the (Setup) screen, touch  repeatedly.
• Press the shutter button halfway down to close the (Setup) screen and return to the shooting mode.

When the menu is not displayed
Press (on-screen key) longer to display the (Setup) screen.
To cancel the (Setup) setting

Touch [Cancel] if it appears. If it does not appear, select the previous setting again.

• This setting is maintained even when the power is turned off.
The default settings are marked with ☑.

### AF Mode

Selects the auto focus operation mode.

| ☑ Single (S AF) | Automatically adjusts the focus when the shutter button is pressed and held halfway down. This mode is useful for shooting stationary subjects. |
| Monitor (M AF)  | Automatically adjusts the focus before the shutter button is pressed and held halfway down. This mode shortens the time needed for focusing. |
|                 | • Battery consumption is faster than in [Single] mode. |

### Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

| ☑ Smart (Smart zoom) (S ✐) | Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [10M] or [3:2]. |
|                            | • The maximum zoom scale of Smart zoom is shown in the following table. |
| Precision (Precision digital zoom) (P ✐) | Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates. |
| Off                        | Does not use the digital zoom. |

Image size and maximum zoom scale using Smart zoom

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M</td>
<td>Approx. 3.4×</td>
</tr>
<tr>
<td>5M</td>
<td>Approx. 4.2×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 5.3×</td>
</tr>
<tr>
<td>2M</td>
<td>Approx. 6.7×</td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td>Approx. 17×</td>
</tr>
<tr>
<td>16:9(HDTV)</td>
<td>Approx. 5.7×</td>
</tr>
</tbody>
</table>
• When you press the zoom button, the zoom scaling indicator appears as follows.

![Zoom scaling indicator diagram]

The W side of this line is the optical zoom area, and the T side is the digital zoom area.

• The maximum zoom scale of smart zoom/precision zoom includes the scale of the optical zoom.
• The AF range finder frame does not appear when using the digital zoom. The 1, 2, or 3 indicator flashes, and AF operates with priority on subjects located near the center of the frame.
• When using the smart zoom, the image on the screen may look rough. However, this phenomenon has no effect on the recorded image.

### Red Eye Reduction

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

<table>
<thead>
<tr>
<th>On (igail)</th>
<th>Reduces the red-eye phenomenon.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The flash pre-strobes twice or more before shooting.</td>
<td></td>
</tr>
<tr>
<td>✔ Off</td>
<td>Does not use Red Eye Reduction.</td>
</tr>
</tbody>
</table>

• Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
• Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.
**AF Illuminator**

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The $\mathcal{F}_{\text{CON}}$ indicator appears at this time.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Auto</td>
<td>Uses the AF illuminator.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use AF illuminator.</td>
</tr>
</tbody>
</table>

- If the AF illuminator light does not reach the subject sufficiently or the subject has no contrast, focus will not be achieved. (A distance of up to approximately 2 m (78 3/4 inches) (zoom: W) / 1.5 m (59 1/16 inches) (zoom: T) is recommended.)
- Focus is achieved as long as the AF illuminator light reaches the subject, even if the light is slightly off the center of the subject.
- When Focus preset is set (page 33), AF Illuminator does not function.
- The AF range finder frame does not appear. The $\mathcal{F}$, $\mathcal{C}$ or $\mathcal{F}_\text{CON}$ indicator flashes, and AF operates with priority on subjects located near the center of the frame.
- The AF illuminator does not operate when ☀ (Twilight mode), $\mathcal{A}$ (Landscape mode) or $\mathcal{F}_{\text{CON}}$ (Fireworks mode) is selected in the Scene mode.
- The AF illuminator emits very bright light. Although there are no problems with safety, do not look directly into the AF illuminator emitter at close range.
The default settings are marked with ✅.

**Auto Review**

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ On</td>
<td>Use the Auto Review.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

- If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
For details on the operation page 62

Internal Memory

This item does not appear when a “Memory Stick Duo” is inserted in the camera.

Format

Formats the internal memory.

- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

The message “All data in internal memory will be erased Ready?” appears.

<table>
<thead>
<tr>
<th>OK</th>
<th>Formats the internal memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>
This item appears only when a “Memory Stick Duo” is inserted in the camera.

**Format**

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

The message “All data in Memory Stick will be erased Ready?” appears.

<table>
<thead>
<tr>
<th>OK</th>
<th>Formats the “Memory Stick Duo”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>

**Create REC. Folder**

Creates a folder in a “Memory Stick Duo” for recording images.

The folder creation screen appears.

- A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

<table>
<thead>
<tr>
<th>OK</th>
<th>A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels folder creation.</td>
</tr>
</tbody>
</table>

- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF.”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 88).
Memory Stick

For details on the operation page 62

Change REC. Folder

Changes the folder currently used for recording images. The folder selection screen appears.

- You cannot select the “100MSDCF” folder as a recording folder.
- You cannot move recorded images to a different folder.

<table>
<thead>
<tr>
<th>OK</th>
<th>Select the desired folder by touching ▲▼, then [OK].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels changing the recording folder.</td>
</tr>
</tbody>
</table>

Copy

Copies all images in the internal memory or the Album to a “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>Internal Memory</th>
<th>Copies the image files in the internal memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Album</td>
<td>Copies the image files in the Album.</td>
</tr>
</tbody>
</table>

① Insert a “Memory Stick Duo” having 32 MB or larger capacity.
② Touch media ([Internal Memory] or [Album]) you want to copy the image files from. The message “All data in internal memory will be copied (All data in Album will be copied) Ready?” appears.
③ Touch [OK]. Copying starts.
• Use a fully charged battery pack or the AC Adaptor (not supplied). If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.
• You cannot copy individual images.
• The original images in the internal memory or Album are retained even after copying. To delete the contents of the internal memory or Album, execute the [Format] command in  (Internal Memory) (page 68) or  (Album) (page 72).
• You cannot select a folder copied on a “Memory Stick Duo”.
• Even if you copy data, a  (Print order) mark is not copied.
• When copying from the Album, the image protection setting is not copied.
• When playing back images in the Album, the order of images displayed on the screen may be different from that of images copied on the “Memory Stick Duo”.
The default settings are marked with ✗.

**Write in Album**

When shooting images, you can choose to save minimized copies of the original images.

| ✗ On (✓)| When shooting images, save minimized copies of the original images in the Album. |
| Off | Does not save minimized copies of the original images in the Album. |

- Still images are recorded in the Album in the [VGA(E-Mail)] image size and the [Standard] picture quality.
- Movies are not recorded in the Album.
- For more details about the Album, see “Using the Album” (page 35).

**Format**

Formats the Album.
- Note that formatting irrevocably erases all data in the Album, including even protected images.

The message “All data in Album will be erased Ready?” appears.

| OK | Formats the Album. |
| Cancel | Cancels the formatting. |

**Check Album**

Repairs the image data in the Album. When “Album data error” appears on the screen, perform this option.

| OK | Repairs the image data. |
| Cancel | Cancels the repair. |

- When you perform [Check Album], the image protection setting is released. Re-protect the images you do not want to be deleted.
Download Music

Downloads the music to be played for the Slide Show.
See pages 38, 95, 97.

Format Music

If you cannot play back a Music file for the Slide Show, the Music file might be corrupted. If
this happens, perform [Format Music], then transfer the music by [Download Music] using the
supplied “Music Transfer” software.
• If you format the write-in-area of the Music file, all Music files are deleted and cannot be restored.
The message “All data will be erased Ready?” appears.

<table>
<thead>
<tr>
<th>OK</th>
<th>Formats the Music files. All data other than Music files remain as it is.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>
The default settings are marked with ✓.

### LCD Backlight

Selects the brightness of the LCD backlight when using the camera with battery pack.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bright</td>
<td>Brightens.</td>
</tr>
<tr>
<td>✓ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can change the setting by pressing [ ] (Screen display switch) button longer.
- Selecting [Bright] uses up the battery pack charge faster.

### Beep

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutter</td>
<td>Turns on the shutter sound when you press the shutter button.</td>
</tr>
<tr>
<td>✓ On</td>
<td>Turns on the beep/shutter sound when you press [ ] (on-screen key)/ press the shutter button/ operate the touch panel buttons.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

### Language

Selects the language to be used to display the menu items, warnings, and messages.

### Initialize

Initializes the setting to the default setting.

The message “Initialize all settings Ready?” appears.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Resets the settings to the default setting.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the resetting.</td>
</tr>
</tbody>
</table>

- Make sure that the power is not disconnected during resetting.
- The data in the internal memory or Album are retained even after resetting.
The default settings are marked with ✓.

### File Number

Selects the method used to assign file numbers to images.

| ✓ Series | Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” is changed. (When the replaced “Memory Stick Duo” contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.) |
| Reset   | Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.) |

### USB Connect

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the cable for multi-use terminal.

| PictBridge | Connects the camera to a PictBridge compliant printer (page 99). |
| PTP        | When [PTP] (Picture Transfer Protocol) is set and the camera is connected to a computer, the images in the recording folder on the camera are copied to the computer. (Compatible with Windows XP and Mac OS X.) |
| Mass Storage | Establishes a Mass Storage connection between the camera and a computer or other USB device (page 84). |
| ✓ Auto     | The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 84 and 99). |
|            | • If the camera and a PictBridge compliant printer cannot be connected when set to [Auto], change the setting to [PictBridge]. |
|            | • If the camera and a computer or other USB device cannot be connected when set to [Auto], change the setting to [Mass Storage]. |
Video Out

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 79 for the TV color system of the country or region where the camera is used.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>

Clock Set

Sets the date and time. Select the date display format on the 1/2 screen, then set the time on the 2/2 screen.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Y/M/D</td>
<td>Select the time display order. Touch → and set the time on the 2/2 screen.</td>
</tr>
<tr>
<td>M/D/Y</td>
<td></td>
</tr>
<tr>
<td>D/M/Y</td>
<td></td>
</tr>
</tbody>
</table>

① Touch the desired date display format, then →.
② Touch the item to be set, then set the numeric value with ▲/▼.
③ Touch [OK].
The default settings are marked with ✓.

### Calibration

Enables you to perform calibration when the touch panel buttons do not react at the appropriate points where you touch.
Using the paint pen, touch the × mark displayed on the screen.
To stop the calibration process mid-way, touch [Cancel]. The adjustments made up to that point are not effected.

The × mark moves on the screen.
If you fail to touch the right spot, the calibration is not performed. Touch the × mark again.

### Housing

Changes the function of some buttons to operate the camera installed in the Marine Pack.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On ( )</td>
<td>Changes the function of the buttons.</td>
<td></td>
</tr>
<tr>
<td>✓ Off</td>
<td>Does not change any functions.</td>
<td></td>
</tr>
</tbody>
</table>

The buttons will work as follows when the setting is [On].

- | (Screen display switch) button: Flash button for shooting. It does not work for viewing.
- / (Playback zoom) button: Zoom button for shooting, Previous/next image button for viewing

- Macro recording is activated automatically when the setting is [On].
- For details, see the operating instructions supplied with the Marine Pack.
Viewing images on a TV screen

You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV.

1. Connect the camera to the TV.

   - Place the camera with the screen facing upwards.
   - If your TV has stereo input jacks, connect the audio plug (black) of the cable for multi-use terminal to the left audio jack.

2. Set the switch on the cable for multi-use terminal to “TV”.

3. Turn on the TV and set the TV/video input switch to “video.”
   - For details, see the operating instructions supplied with the TV.

4. Set the mode switch to , and turn on the camera.

   Images shot with the camera appear on the TV screen.
   Images disappear and buttons appear on the camera screen.
   Touch on the camera screen to switch the image back and forth on the TV screen.
   Operate the menu by touching to move the cursor, then to set.
   - When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 76).
On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal. The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

**NTSC system**
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**
Brazil

**PAL-N system**
Argentina, Paraguay, Uruguay

**SECAM system**
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 96). This section describes the English version of screen contents.

Installing the software (supplied) first (page 82)

Copying images to your computer (page 83)

- Viewing images on your computer

Enjoying images using the “Picture Motion Browser” and “Music Transfer” (pages 91 and 95)

- Viewing images saved on your computer
- Viewing photos organized by date
- Editing images
- Adding/changing Music using “Music Transfer”
- Printing images
Recommended computer environment

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images


- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

USB jack: Provided as standard

Recommended environment for using “Picture Motion Browser” and “Music Transfer”


Sound card: 16-bit stereo sound card with speakers

CPU/Memory: Pentium III 500 MHz or faster, 128 MB of RAM or more
(Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

Software: DirectX 9.0c or later

Hard Disk: Disk space required for installation—200 MB or more

Display: Screen resolution: 1024 × 768 dots or more
- Colors: High Color (16-bit color) or more
- The software is compatible with DirectX technology. Installation of “DirectX” may be required.

Notes on connecting your camera to a computer

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 75.
- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website. http://www.sony.net/
Installing the software (supplied)

You can install the software (supplied) using the following procedure.
- When using Windows 2000/Me, do not connect the camera to the computer before installation.
- In Windows 2000/XP, log on as Administrator.
- When the supplied software is installed, the USB driver is installed automatically.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
   The installation menu screen appears.

   - If it does not appear, double-click (My Computer) → (SONYPICTUTIL).

2 Click [Install].
   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].
   The “License Agreement” screen appears.
   Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

4 Follow the instructions on the screen to complete the installation.
   - When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   - DirectX may be installed depending on system environment of your computer.

5 Remove the CD-ROM after the installation is complete.
   After you install the software, a shortcut icon for the customers registration website is created on the desktop.
   Once you register on the website, you can get secure and useful customer support. http://www.sony.net/registration/di
Copying images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a Memory Stick slot
Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor. Insert the Memory Stick Duo Adaptor in the computer and copy the images.

- Even when you are using Windows 95/98/98 Second Edition/NT, you can copy images by inserting the “Memory Stick Duo” into the Memory Stick slot on your computer.
- If the “Memory Stick PRO Duo” is not recognized, see page 110.

For a computer without a Memory Stick slot
Follow Stages 1 through 4 on pages 83 to 87 to copy images.

- When you are using Windows 2000/Me, install the software (supplied) before proceeding. With Windows XP, the installation is unnecessary.
- The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

With Windows 95/98/98 Second Edition/NT:
This camera is not compatible with these versions of the Windows operating system. When you use a computer without a Memory Stick slot, use a “Memory Stick Reader/Writer” (not supplied) to copy images from a “Memory Stick Duo” to your computer.
To copy images in the internal memory to your computer, copy the images to a “Memory Stick Duo” first, then copy them to your computer as described above.

Stage 1: Preparing the camera and the computer

1. Insert a “Memory Stick Duo” with recorded images into the camera.
   - When copying images in the internal memory, this step is unnecessary.

2. Insert the sufficiently charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied) (page 12).
   - When you copy images to your computer using a battery pack with little remaining charge, copying may fail or image data may become corrupted if the battery pack shuts down too soon.

3. Set the mode switch to , then turn on the camera and the computer.
Copying images to your computer

Stage 2: Connecting the camera and your computer

1 Connect the camera to your computer.

2 Set the switch on the cable for multi-use terminal to “CAMERA”.

   - With Windows XP, the AutoPlay wizard appears on the desktop.

“USB Mode Mass Storage” appears on the screen of the camera.

When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.

* During communication, the access indicators turn red. Do not operate the computer until the indicators turn white.

- When the software (supplied) has been installed, the [Import Images] screen (page 91) may be displayed. In this case, you can import images using “Picture Motion Browser” directly.

Stage 3-A: Copying images to a computer

- For Windows 2000/Me, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 86.
- For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 86.

This section describes an example of copying images to a “My Documents” folder.
1 After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

![Scanner and Camera Wizard screen](image)

The “Scanner and Camera Wizard” screen appears.

2 Click [Next].

The images saved on the “Memory Stick Duo” of the camera appear.

- If no “Memory Stick Duo” is inserted, images in the internal memory appear.

3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

![Image selection screen](image)

The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

![Rename and destination screen](image)

Image copying starts. When the copying is completed, the “Other Options” screen appears.

- This section describes an example of copying images to the “My Documents” folder.
5 Click the radio button next to [Nothing. I'm finished working with these pictures] to select it, then click [Next].

The “Completing the Scanner and Camera Wizard” screen appears.

6 Click [Finish].

The wizard screen closes.

- To continue copying other images, disconnect the cable for multi-use terminal (page 88). Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 84.

Stage 3-B: Copying images to a Computer

- For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 84.

This section describes an example of copying images to the “My Documents” folder.

1 Double-click [My Computer] → [Removable Disk] → [DCIM].

- If the “Removable Disk” icon is not displayed, see page 111.

2 Double-click the folder where the image files you want to copy are stored. Then, right-click an image file to display the menu and click [Copy].

- On the storage destination of the image files, see page 88.
3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

The image files are copied to the “My Documents” folder.

• When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 90), you may not be able to play back that image with your camera.

Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1 Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.

• If you are not using Windows XP, double-click [My Documents] on the desktop.

2 Double-click the desired image file.

The image is displayed.
To delete the USB connection

Perform the procedures listed below beforehand when:
• Disconnecting the cable for multi-use terminal
• Removing a “Memory Stick Duo”
• Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
• Turning off the camera

① Double-click  on the tasktray.

Double-click here

② Click  (Sony DSC) → [Stop].

③ Confirm the device on the confirmation window, then click [OK].

④ Click [OK].
   The device is disconnected.
   • Step ④ is unnecessary for Windows XP.

Image file storage destinations and file names

The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

Example: viewing folders on Windows XP

A Folder containing image data recorded using a camera not equipped with the folder creating function

B Folder containing image data recorded using this camera
   When no new folders are created, there are folders as follows:
   – “Memory Stick Duo”; “101MSDCF” only
   – Internal memory; “101_SONY” only

• You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
• You cannot record/playback any images to the “MISC” folder.
Copying images to your computer

- Image files are named as follows. □□□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  - Still image files: DSC0□□□□.JPG
  - Movie files: MOV0□□□□.MPG
  - Index image files that are recorded when you record movies: MOV0□□□□.THM
- For more information about folders, see pages 54 and 69.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, create a folder with your camera (page 69) first, and then copy the image file.

1 Right-click the image file, then click [Rename]. Change the file name to “DSC0sss.sss.”

   Enter a number from 0001 to 9999 for sss.

   - If the overwrite confirmation message appears, enter a different number.
   - An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is MPG. Do not change the extension.

2 Copy the image file to the “Memory Stick Duo” folder in the following order.

   ① Right-click the image file, then click [Copy].
   ② Double-click [Removable Disk] or [Sony MemoryStick] in [My Computer].
   ③ Right-click the [□□□MSDCF] folder in the [DCIM] folder, then click [Paste].

      - □□□ stands for any number within the range from 100 to 999.
Using the “Picture Motion Browser” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software.
This section summarizes the “Picture Motion Browser” and gives the basic instructions.

“Picture Motion Browser” overview

With the “Picture Motion Browser” you can:
• Import images shot with the camera and display them on the computer.
• Organize images on the computer on a calendar by shooting date to view them.
• Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
• For details on the “Picture Motion Browser”, refer to the Help.

To access the Help, click [Start] ➔ [All Programs] (in Windows 2000/Me, [Programs]) ➔ [Sony Picture Utility] ➔ [Help] ➔ [Picture Motion Browser].

Starting and exiting the “Picture Motion Browser”

Starting the “Picture Motion Browser”
Double-click the  (Picture Motion Browser) icon on the desktop.
Or, from the Start menu: Click [Start] ➔ [All Programs] (in Windows 2000/Me, [Programs]) ➔ [Sony Picture Utility] ➔ [Help] ➔ [Picture Motion Browser].

Exiting the “Picture Motion Browser”
Click  button in the top right corner of the screen.

Basic instructions

Follow these steps to import and view images from the camera.

Importing images

1 Make sure “Media Check Tool”* is running.

Look for a  (Media Check Tool) icon in the taskbar.
* “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.
• If there is no  icon: Click [Start] ➔ [All Programs] (in Windows 2000/Me, [Programs]) ➔ [Sony Picture Utility] ➔ [Tools] ➔ [Media Check Tool].

2 Connect the camera to your computer with the cable for multi-use terminal.

After the camera is automatically detected, the [Import Images] screen is displayed.

• If you use the Memory Stick slot, refer to page 83 first.
• In Windows XP, if the AutoPlay Wizard appears, close it.
3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.

- For instructions on changing the “Folder to be imported”, refer to page 94.

Viewing images

1 Checking imported images

When importing is complete, the “Picture Motion Browser” starts. Thumbnails of the imported images are displayed.

- The “My Pictures” folder is set as the default folder in “Viewed folders”.
- You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.

② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.

③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.

④ To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.

Year display screen

Month display screen
Using the “Picture Motion Browser” (supplied)

Hour display screen

- To list images from a particular year or month, click that period on the left of the screen.

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

- You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

- To stop the slide show, click the button on the lower left of the screen.
- To play or pause the slide show, click the button on the lower left of the screen.
Other functions

Preparing images stored on the computer for viewing

Register the folder that contains the images as one of the “Viewed folders”.

1 Click on the main screen, or choose [Register Folders to View] from the [File] menu.

The settings screen for “Viewed folders” registration is displayed.

2 Specify the folder with images for importing to register the folder as one of the “Viewed folders”.

3 Click [OK].

The image information is registered in the database.

- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”

To change the “Folder to be imported”, access the “Import Settings” screen.

1 Choose [Import Settings] → [Location for Imported Images] from the [File] menu.

The “Location for Imported Images” screen is displayed.

2 Choose the “Folder to be imported”.

- You can specify the “Folder to be imported” from folders registered as “Viewed folders.”

Updating image registration information

To update image information, choose [Update Database] from the [Tools] menu.
- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

To uninstall the “Picture Motion Browser”

1 Click [Start] → [Control Panel] (in Windows 2000/Me, [Start] → [Settings] → [Control Panel]), then double-click [Add/Remove Programs].

2 Select [Sony Picture Utility], then click [Remove] (in Windows 2000/Me, [Change/Remove]) to execute the uninstallation.
Using the “Music Transfer” (supplied)

You can change the Music files that are preset at the factory with desired Music files using “Music Transfer” in the CD-ROM (supplied). Also, you can delete or add these files whenever you want.

**Adding/Changing Music using “Music Transfer”**

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard drive of your computer
- Music on CDs
- Preset-music saved on this camera

1. Press (on-screen key) to display [MENU].

2. Touch [MENU], then select (Setup).

3. Select (Setup 1) with ▲/▼, then touch [Download Music].
   The message “Connect to PC” appears.

4. Make a USB connection between the camera and your computer.

5. Start “Music Transfer.”

6. Follow the instructions on the screen to add/change Music files.

- To restore the music preset at the factory to the camera:
  2. Execute [Restore defaults] on “Music Transfer.”
     All Music files return to the preset-music, and [Music] in the [Slide Show] menu is set to [Off].
  3. Select a suitable Music file for the slide show effect (page 38).
     You can reset the Music files to the preset ones using [Initialize] (page 74), however, other settings will also be reset.
- For details on using “Music Transfer,” see the on-line help in “Music Transfer.”
Using your Macintosh computer

You can copy images to your Macintosh computer.
• “Picture Motion Browser” is not compatible with Macintosh computers.

Recommended computer environment

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images

OS (pre-installed): Mac OS 9.1/9.2/ Mac OS X(v10.1 to v10.4)
USB jack: Provided as standard

Recommended environment for using “Music Transfer”

OS (pre-installed): Mac OS X (v10.3 to v10.4)
Memory: 64 MB or more (128 MB or more is recommended)
Hard Disk: Disk space required for installation—approximately 250 MB

Notes on connecting your camera to a computer

• Operations are not guaranteed for all the recommended computer environments mentioned above.
• If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
• Operations are not guaranteed when using a USB hub.
• Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
• There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 75.
• When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

Copying and viewing images on a computer

1 Prepare the camera and a Macintosh computer.

Perform the same procedure as described in “Stage 1: Preparing the camera and the computer” on page 83.

2 Connect the cable for multi-use terminal.

Perform the same procedure as described in “Stage 2: Connecting the camera and your computer” on page 84.

3 Copy image files to the Macintosh computer.

① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
② Drag and drop the image files to the hard disk icon.
The image files are copied to the hard disk.
• For details on the storage location of the images and file names, see page 88.
4 View images on the computer.

Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.

To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

Adding/Changing Music using “Music Transfer”

You can change the Music files that are preset at the factory with desired Music files. Also, you can delete or add these files whenever you want.

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard drive of your computer
- Music on CDs
- Preset-music saved on this camera

To install “Music Transfer”
- Shut down all other application software before you install “Music Transfer.”
- For installation, you need to log on as Administrator.

① Turn on your Macintosh computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
② Double-click (SONYPICTUTIL).
The installation of the software starts.

To add/change Music files


Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.  
http://www.sony.net/
When you print images shot in [16:9(HDTV)] mode, both side edges may be cut off, so be sure to check before printing (page 113).

**Printing directly using a PictBridge compliant printer (page 99)**

You can print images by connecting the camera directly to a PictBridge compliant printer.

**Printing directly using a “Memory Stick” compliant printer**

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

**Printing using a computer**

You can copy images to a computer using the supplied “Picture Motion Browser” software and print the images.

**Printing at a shop (page 103)**

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a (Print order) mark on images which you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

PictBridge

- “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)

In single-image mode
You can print a single image on a printing sheet.

In index mode
You can print several images at a reduced size on a printing sheet. You can print a set of either the same images (①) or different images (②).

- An index print function may not be provided depending on the printer.
- The quantity of images that can be printed as an index image differ depending on the printer.
- You cannot print movies or the images saved in the Album.
- If the indicator flashes on the screen of the camera for about five seconds (error notification), check the connected printer.

Stage 1: Preparing the camera
Prepare the camera to connect it to the printer with the cable for multi-use terminal. When connecting the camera to a printer that is recognized when [USB Connect] is set to [Auto], Stage 1 is unnecessary.

1 Touch [MENU] to display the menu.

2 Touch ▼ to display (Setup).

3 Touch [USB Connect] in (Setup 3).

4 Touch [PictBridge], then ➪.

The USB mode is set.

- It is recommended to use a fully charged battery pack or an AC Adaptor (not supplied) to prevent the power from turning off partway through printing.
Printing images directly using a PictBridge compliant printer

Stage 2: Connecting the camera to the printer

1 Connect the camera to the printer.

2 Set the switch on the cable for multi-use terminal to “CAMERA”.

Stage 3: Printing

Regardless of what the mode switch is set to, the print menu appears when you complete Stage 2.

1 Touch the desired printing method.

[This image]
Prints a displayed image.
• If you select [This image] and set [Index] to [On] in step 2, you can print a set of the same images as an index image.

[Select]
Selects images and prints all the selected images.

   1 Select the image you want to print with [◀/▶], then touch [Select].
   The mark appears on the selected image.
   • To select other images, repeat this procedure.

   2 Touch [Print].

[DPOF image]
Prints all the images with a (Print order) mark (page 103) regardless of the displayed image.

3 Turn on your camera and the printer.

The camera is set to playback mode, then an image and the print menu appear on the screen.
Printing images directly using a PictBridge compliant printer

[All In This Folder]
Prints all the images in the folder.

2 Make print settings by touching desired items.

[Quantity]
When [Index] is set to [Off]:
Select the number of sheets of an image that you want to print. The image will be printed as a single image.

When [Index] is set to [On]:
Select the number of sets of images that you want to print as an index image. If you selected [This image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.

- The designated number of images may not all fit onto a single sheet depending on the quantity of images.

[Date]
Select [Day&Time] or [Date] to insert the date and time on images.

- When you choose [Date], the date will be inserted in the order you select (page 76). This function may not be provided depending on the printer.

[Size]
Select the size of the printing sheet.

[Index]
Select [On] to print as an index image.

3 Touch [OK].
The image is printed.

- Do not disconnect the cable for multi-use terminal while the \(\text{Connecting}\) indicator appears on the screen.

To print other images
After step 3, touch [Select] and the desired image, then perform from step 1.

To print images on the index screen
Perform “Stage 1: Preparing the camera” (page 99) and “Stage 2: Connecting the camera to the printer” (page 100), then proceed with the following.
When you connect the camera to a printer, the print menu appears. Press \(\text{(on-screen key)}\) to turn off the print menu, then proceed as follows.

1. Press \(\text{ (Index).}\)
   The index screen appears.
2. Touch [MENU] to display the menu.
3. Touch \(\text{ (Print).}\)
4. Touch the desired printing method.
[Select]
Selects images and prints all the selected images.
Touch the image you want to print to display the ✔ mark. (Repeat this procedure to select other images.)

[DPOF image]
Prints all the images with a ☑ (Print order) mark regardless of the displayed image.

[All In This Folder]
Prints all the images in the folder.

Perform steps 2 and 3 of “Stage 3: Printing” (page 100).
Printing at a shop

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

What is DPOF?

DPOF (Digital Print Order Format) is a function allowing you to make a (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

- You cannot mark movies.
- When you mark images shot in [Multi Burst] mode, all the images are printed on one sheet divided into 16 panels.
- You cannot mark images saved in the Album.

When taking a “Memory Stick Duo” to a shop

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
- Be sure to take the Memory Stick Duo Adaptor with “Memory Stick Duo”.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.

Marking in single-image mode

1. Display the image you want to print.
2. Touch [MENU] to display the menu.
3. Touch ▲▼ to display [DPOF], then touch it.
4. Touch [DPOF].
   A (Print order) mark is marked on the image.
5. To mark other images, display the desired image with ▼/▲, then touch [DPOF].

To remove the mark in single-image mode

Touch [DPOF] in step 4 or 5.
Marking in index mode

1 Display the index screen (page 27).

2 Touch [MENU] to display the menu.

3 Touch ▲/▼ to display [DPOF], then touch it.

4 Touch [Select].
   • You cannot add a  mark in [All In This Folder].

5 Touch the image you want to mark.
   A green  mark appears on the selected image.

6 Repeat step 5 to mark other images.

7 Touch [OK] → [OK].

To remove the mark in index mode
Touch the images from which you want to remove the mark in step 5.

To remove all the marks in the folder
Select [All In This Folder] in step 4, then touch [Off].

To cancel, select [Exit] in step 5 or select [Cancel] in step 7.
If you experience trouble with your camera, try the following solutions.

1. **Check the items on pages 106 to 116.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 117.

2. **Remove the battery pack, and insert the battery pack again after about one minute, and turn on the power.**

3. **Initialize the settings (page 74).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

Please understand that you give your consent that the contents of the internal memory, Album, Music files may be checked when you send your camera to be repaired.

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.

<table>
<thead>
<tr>
<th>Battery pack and power 106</th>
<th>Internal memory 112</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shooting still images/movies 106</td>
<td>Album 113</td>
</tr>
<tr>
<td>Viewing images 108</td>
<td>Printing 113</td>
</tr>
<tr>
<td>Deleting/Editing images 109</td>
<td>PictBridge compliant printer 114</td>
</tr>
<tr>
<td>Computers 110</td>
<td>Touch panel 115</td>
</tr>
<tr>
<td>Picture Motion Browser 112</td>
<td>Others 116</td>
</tr>
<tr>
<td>“Memory Stick Duo” 112</td>
<td></td>
</tr>
</tbody>
</table>
## Battery pack and power

### The battery pack cannot be installed.
- Install the battery pack correctly using the tip of the battery pack to push the battery eject lever toward the bottom of the camera.

### Cannot turn on the camera.
- Install the battery pack correctly.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 124). Replace it with a new one.
- Use a recommended battery pack.

### The power turns off suddenly.
- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
- The battery pack is dead (page 124). Replace it with a new one.

### The battery remaining indicator is incorrect.
- This phenomenon occurs when you use the camera in an extremely hot or cold location.
- The displayed battery remaining differs from the current one. Fully discharge and then charge the battery pack to correct the display.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 124). Replace it with a new one.

## Shooting still images/movies

### Your camera cannot record images.
- Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  - Delete unnecessary images (page 26).
  - Change the “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 122).
- You cannot record images while charging the flash.
- Set the mode switch to [  ] when shooting still images.
- Set the mode switch to [ ] when shooting movies.
- The image size is set to [640(Fine)] when recording movies. Do one of the following:
  - Set the image size to other than [640(Fine)].
  - Insert a “Memory Stick PRO Duo”.

### Recording takes a long time.
- The NR slow shutter function is activated (page 13). This is not a malfunction.
Troubleshooting

The image is out of focus.

- The subject is too close. Shoot in 📷 (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 6 cm or farther (2 3/8 inches or farther) (W)/34 cm or farther (13 3/8 inches or farther) (T), when shooting.
- 🌃 (Twilight mode), 🏞 (Landscape mode) or 🎆 (Fireworks mode) is selected in the Scene mode when shooting still images.
- The Focus preset function is selected. Select the auto focus mode (page 33).

Zoom does not work.

- The smart zoom cannot be used when:
  - The image size is set to [10M] or [3:2].
  - Shooting in Multi Burst mode.
- The digital zoom cannot be used while shooting movies.

The flash does not work.

- The flash is set to 📷 (No Flash) (page 23).
- You cannot use the flash when:
  - [Mode] (REC Mode) is set to [Burst], [Exp Brktg] or [Multi Burst] (page 50).
  - 🌃 (High sensitivity mode), 🌃 (Twilight mode) or 🎆 (Fireworks mode) is selected in the Scene mode (page 30).
  - Shooting movies.
- Set the flash to 📷 (Forcedflash) when 🏞 (Landscape mode), 🏖 (Beach mode), or 🎅 (Snow mode) is selected in the Scene mode (page 23).

Fuzzy specks appear in images shot using the flash.

- Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.

The close-up shoot function (Macro) does not work.

- 🌃 (Twilight mode), 🏞 (Landscape mode) or 🎆 (Fireworks mode) is selected in the Scene mode (page 30).

The date and time are not displayed on the LCD screen.

- While shooting, the date and time are not displayed. They are displayed only during playback.

Cannot insert dates on images.

- This camera does not have a feature for superimposing dates on images (page 114).

The F value and shutter speed flash when you press and hold the shutter button halfway down.

- The exposure is incorrect. Correct the exposure (page 31).
Troubleshooting

The screen is too dark or too bright.
• Adjust the brightness of the LCD backlight (pages 17, 74).

The image is too dark.
• You are shooting a subject with a light source behind the subject. Select the metering mode (page 47) or adjust the exposure (page 31).

The image is too bright.
• Adjust the exposure (page 31).

The image colors are not correct.
• Set [COLOR] (Color Mode) to [Normal] (page 46).

Vertical streaks appear when you are shooting a very bright subject.
• The smear phenomenon is occurring. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.
• The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.
• Set [Red Eye Reduction] in the (Setup) menu to [On] (page 65).
• Shoot the subject at a distance closer than the flash range using the flash.
• Light the room and shoot the subject.

Dots appear and remain on the screen.
• This is not a malfunction. These dots are not recorded (page 2).

Cannot shoot images in succession.
• The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 26).
• The battery level is low. Install the charged battery pack.

Viewing images

Your camera cannot play back images.
• The folder/file name has been changed on your computer (page 90).
• When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
• The camera is in USB mode. Delete the USB connection (page 88).
Troubleshooting

The date and time are not displayed.

- (Screen display switch) button is turned off (page 17).

The image appears rough right after playback starts.

- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

The image does not appear on the screen when a USB connection is made.

- The switch on the cable for multi-use terminal is set to “TV”. Disconnect the cable for multi-use terminal or set the switch to “CAMERA” (page 84).

The image does not appear on the TV screen.

- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 76).
- Check whether the connection is correct (page 78).
- The switch on the cable for multi-use terminal is set to “CAMERA”. Set to “TV” (page 78).

Deleting/Editing images

Your camera cannot delete an image.

- Cancel the protection (page 56).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 122).

You have deleted an image by mistake.

- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 55), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 122) to prevent accidental erasure.

The resizing function does not work.

- You cannot resize movies, Multi Burst images, and images in the Album.

You cannot cut a movie.

- The movie is not long enough to cut (shorter than about two seconds).
- Cancel the protection (page 56).

You cannot paint.

- You cannot paint on images in the Album.
- There is not enough free-capacity in media. Delete unnecessary images.
Computers

You do not know if the OS of your computer is compatible with the camera.

- Check “Recommended computer environment” on page 81 for Windows, and page 96 for Macintosh.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.

- Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Reader/Writer made by manufacturers other than Sony should contact those manufacturers.
- If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (pages 84 and 96). The computer recognizes the “Memory Stick PRO Duo”.

Nothing appears on the camera screen when a USB connection is made.

- The switch on the cable for multi-use terminal is set to “TV”. Set to “CAMERA” (page 84).

Your computer does not recognize your camera.

- Turn on the camera.
- When the battery level is low, install the charged battery pack, or use the AC Adaptor (not supplied).
- Set [USB Connect] to [Mass Storage] in the (Setup) menu (page 75).
- Use the cable for multi-use terminal (supplied) (page 84).
- Disconnect the cable for multi-use terminal from both the computer and the camera, and connect it again firmly.
- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
- Connect the camera directly to your computer without passing through a USB hub or other device (page 84).
- The software (supplied) is not installed. Install the software (page 82).
- Your computer does not properly recognize the device because you connected the camera and your computer with the cable for multi-use terminal before you install the software (supplied). Delete the erroneously recognized device from your computer, then install the USB driver (see the next item).
The “Removable disk” icon does not appear on the computer screen when you connect your computer to the camera.

- Follow the procedure below to install the USB driver again. The following procedure is for a Windows computer.
  1 Right-click [My Computer] to display the menu, then click [Properties].
     The “System Properties” screen appears.
  2 Click [Hardware] → [Device Manager].
     For Windows Me, click the [Device Manager] tab.
     The “Device Manager” appears.
  3 Right-click [Sony DSC], then click [Uninstall] → [OK].
     The device is deleted.
  4 Install the software (page 82).
     A USB driver is also installed.

You cannot copy images.

- Connect the camera and your computer correctly making a USB connection (page 84).
- Follow the designated copy procedure for your OS (pages 84 and 96).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 69).

After making a USB connection, “Picture Motion Browser” does not start automatically.

- Start “Media Check Tool” (page 91).
- Make the USB connection after the computer is turned on (page 84).

The image cannot be played back on a computer.

- If you are using “Picture Motion Browser,” refer to the Help.
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.

- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 83).

You cannot print an image.

- Refer to the operation manual of the printer.

Images once copied to a computer cannot be viewed on the camera.

- Copy them to a folder recognized by the camera, such as “101MSDCF” (page 88).
- Operate correctly (page 90).
Troubleshooting

**Picture Motion Browser**

Images are not displayed correctly with “Picture Motion Browser”.

- Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 94).

You cannot find images imported with “Picture Motion Browser”.

- Look in the “My Pictures” folder.
- If you have changed the default settings, refer to “Changing the “Folder to be imported”” on page 94 and check what folder is used for importing.

You want to change the “Folder to be imported”.

- Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Picture Motion Browser” to register it in “Viewed folders” (page 94).

All imported images are displayed on the calendar with the date January 1.

- The date has not been set on the camera. Set the date on the camera (page 76).

**“Memory Stick Duo”**

Cannot insert a “Memory Stick Duo”.

- Insert it in the correct direction.

Cannot format a “Memory Stick Duo”.

- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 122).

You have formatted a “Memory Stick Duo” by mistake.

- All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 122).

**Internal memory**

Cannot play back or record images using the internal memory.

- There is a “Memory Stick Duo” inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

- The “Memory Stick Duo” is full. Check the capacity (32 MB or more recommended).
Troubleshooting

Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.
  • Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

**Album**

The free capacity of the Album does not increase even when you copy the data stored in the Album to a “Memory Stick Duo”.
  • The data is not deleted after copying.

Cannot copy the data stored in the Album to a “Memory Stick Duo”.
  • The “Memory Stick Duo” is full. Check the capacity (32 MB or more recommended).

Cannot copy the data on the “Memory Stick Duo” or the computer to the Album.
  • Data on a “Memory Stick Duo” or a computer cannot be copied to the Album.

Cannot record images to the Album.
  • Set [Write in Album] to [On] in the (Setup) menu (page 72).
  • The capacity of the Album is full of protected images. Remove the protection from unwanted images (page 56).

**Printing**

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both side edges cut off.
  • Depending on your printer, the left, right, top, and bottom edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9(HDTV)], the edge of the image may be cut off.
  • When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
  • When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

Images with 16 frames are printed.
  • Images shot in the Multi Burst mode are recorded as a single image with 16 frames. You cannot print the image frame-by-frame.
Troubleshooting

Cannot print images with the date inserted.

- If you print out images using “Picture Motion Browser”, the images can be printed with date inserted.
- This camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
- When you print images at a shop, images can be printed with the date inserted if you ask them to do so.

PictBridge compliant printer

A connection cannot be established.

- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] in the (Setup) menu (page 75).
- Disconnect and connect the cable for multi-use terminal again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Nothing appears on the camera screen when a USB connection is made.

- The switch on the cable for multi-use terminal is set to “TV”. Set to “CAMERA” (page 100).

Cannot print images.

- Check that the camera and the printer are properly connected using the cable for multi-use terminal.
- Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the cable for multi-use terminal again. If you still cannot print your images, disconnect the cable for multi-use terminal, turn the printer off and then on, then connect the cable for multi-use terminal again.
- You cannot print movies or the images saved in the Album.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.

- You disconnected the cable for multi-use terminal before the (PictBridge Connecting) mark disappears.
Troubleshooting

Cannot insert the date or print images in the index mode.
- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.
- Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 101).

Cannot select the print size.
- Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
- Disconnect the cable for multi-use terminal and reconnect it whenever you change the paper size after the printer has been connected to the camera.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 101) or the printer.

Cannot operate the camera after canceling printing.
- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Touch panel

The touch panel buttons do not appear.
- Press (on-screen key).

Cannot operate the touch panel buttons correctly or fully.
- Perform [Calibration] (page 77).

The paint pen operation reacts at inappropriate points.
- Perform [Calibration] (page 77).

Buttons do not work as they should.
- [Housing] is set to [On] (page 77).
Troubleshooting

**Others**

**The camera does not function with the lens portion extended.**
- Do not attempt to force the lens that has stopped moving.
- Insert a charged battery pack, then turn on the camera again.

**The lens gets fogged.**
- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

**The camera becomes warm when you use it for a long time.**
- This is not a malfunction.

**The Clock Set screen appears when you turn on the camera.**
- Set the date and time again (page 76).

**You want to change the date or time.**
- Set the date and time again (page 76).
Warning indicators and messages

Self-diagnosis display
If a code starting with a letter of the alphabet appears, your camera has a self-diagnosis display. The last two digits (indicated by □□) will differ depending on the state of the camera.
If you are unable to solve the problem even after trying the following corrective actions a few times, your camera may need repair. Contact your Sony dealer or local authorized Sony service facility.

C:32:□□
- There is trouble with your camera’s hardware. Turn the power off and on again.

C:13:□□
- The camera cannot read or write data on the “Memory Stick Duo”. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” several times.
- The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (pages 68, 69).
- The inserted “Memory Stick Duo” cannot be used with your camera, or the data is damaged. Insert a new “Memory Stick Duo”.

E:61:□□

E:91:□□
- A camera malfunction has occurred. Initialize the camera (page 74), then turn the power on again.

Messages
If the following messages appear, follow the instructions.

- The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
- The battery inserted is not an NP-BG1 battery pack.

System error
- Turn the power off and then on again.

Internal memory error
- Turn the power off and then on again.

Reinsert the Memory Stick
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in your camera (page 122).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
- The inserted “Memory Stick Duo” cannot be used in your camera (page 122).

Format error
- Format the media again (pages 68, 69 and 72).
Warning indicators and messages

**Memory Stick locked**
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 122).

**No memory space in internal memory**

**No memory space in Memory Stick**
- Delete unnecessary images or files (page 26).

**Read only memory**
- Your camera cannot record or delete images on this “Memory Stick Duo”.

**No file**
- No images have been recorded in the internal memory.

**No file in this folder**
- No images have been recorded in this folder.
- You did not operate correctly when copying images from your computer (page 90).

**Folder error**
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCDE). Select other folders, or create a new folder (pages 70, 69).

**Cannot create more folders**
- The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.

**Cannot record**
- The camera cannot record images in the selected folder. Select a different folder (page 70).

**File error**
- An error occurred while the image was playing back.

**File protect**
- Release the protection (page 56).

**Image size over**
- You are playing back an image of a size that cannot be played back on your camera.

**Cannot divide**
- The movie is not long enough to be divided (shorter than about two seconds).
- The file is not a movie.

**Invalid operation**
- You are trying to play back a file that is not compatible with the camera.
- On movies, you tried to zoom, paint, resize, rotate, print, or set DPOF.
- On Multi Burst images, you tried to zoom, paint, resize, or rotate.
- You tried to paint while viewing recorded images on a TV.
- You tried to paint using the remote controller of the Cyber-shot Station.

**Camera shake warning indicator**
- Camera shake may occur due to insufficient light. Use the flash, mount the camera on a tripod, or otherwise secure the camera in place.
**640(Fine) is not available**

- 640(Fine) size movies can be recorded only using a “Memory Stick PRO Duo”. Insert a “Memory Stick PRO Duo” or set the image size to a size other than [640(Fine)].

**Enable printer to connect**

- [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
- The connection is not established. Disconnect and connect the cable for multi-use terminal again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

**Connect to PictBridge device**

- You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

**No printable image**

- You tried to execute [DPOF image] without placing a DPOF (Print order) mark on the image(s).
- You tried to execute [All In This Folder] while a folder that holds only movies was selected. You cannot print movies.

**Printer error**

- Check the printer.
- Check if the image you want to print is corrupted.

- The data transmission to the printer may not be completed yet. Do not disconnect the cable for multi-use terminal.

**Processing**

- The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

**Album data error**

- An error in image data in the Album data has occurred. Perform [Check Album] (page 72).

**Album error**

- An error in the Album has occurred. Turn the camera off, then on again. If the message still appears, format the Album. (In this case of formatting, note that all image data, including the protected images, in the Album will be erased.)

**No image for Slide Show**

- The selected folder does not contain a file that can be played in a Slide Show with music.

**Music Error**

- Delete the Music file, or replace it with a normal Music file.
- Execute [Format Music], then download a new Music files (page 73).
Warning indicators and messages

Format Music Error
  • Execute [Format Music] (page 73).

Operation is changed
  • [Housing] is set to [On] (page 77).
To use your camera abroad — Power sources

You can use your camera, the battery charger (supplied), and the AC-LS5K AC Adaptor (not supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
On the “Memory Stick”

A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

### Notes on using a “Memory Stick Duo” (not supplied)
- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.

![Memory Stick Duo](image)

- **Terminal**
- **Write-protect switch**
- **Memo area**

Some “Memory Stick Duo” cards do not have a write-protect switch. On “Memory Stick Duo” with this switch, the position and shape may vary depending on the “Memory Stick Duo”.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2*3</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

*3 640(Fine) size movies can be recorded.

- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.
On the “Memory Stick”

- Do not use or store the “Memory Stick Duo” under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

- To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 2 GB have been confirmed to operate properly with this camera.
On the battery pack

On charging the battery pack

We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). You may not be able to efficiently charge the battery pack outside of this temperature range.

Effective use of the battery pack

• Battery performance decreases in low temperature surroundings. So, the time that the battery pack can be used is shorter in cold places. We recommend the following to ensure longer battery pack use:
  – Put the battery pack in a pocket close to your body to warm it up, and insert it in your camera immediately before you start shooting.
• The battery pack will run out quickly if you use the flash or zoom frequently.
• We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
• Do not expose the battery pack to water. The battery pack is not water-resistant.
• Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack

• If the battery pack is not to be used for a long time, fully charge it and then fully use it up once a year on your camera before storing the battery pack in a dry, cool place. Repeat this charging and using up once a year to maintain the battery pack’s function.
• To use the battery pack up, leave your camera in slide show playback mode (page 38) until the power goes off.
• To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life

• The battery life is limited. Battery capacity decreases little by little as you use it more and more, and as time passes. If the battery operating time seems shortened considerably, a probable cause is that the battery pack has reached the end of its life. Buy a new battery pack.
• The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.
On the battery charger

- Do not charge any battery pack other than the supplied NP-BG type battery packs in the battery charger supplied with your camera. Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.

- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be shortened.

- When the CHARGE lamp flashes, this may indicate a battery error or that a battery pack other than the specified type have been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.

- If the battery charger is dirty, charging may not be performed successfully. Clean the battery charger with dry cloth, etc.
<table>
<thead>
<tr>
<th>A</th>
<th>126</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Adaptor</td>
<td>12</td>
</tr>
<tr>
<td>AE/AF lock indicator</td>
<td>22</td>
</tr>
<tr>
<td>AF Illuminator</td>
<td>66</td>
</tr>
<tr>
<td>AF Mode</td>
<td>64</td>
</tr>
<tr>
<td>AF range finder frame</td>
<td>33</td>
</tr>
<tr>
<td>AF range finder frame indicator</td>
<td>33</td>
</tr>
<tr>
<td>Album</td>
<td>35, 72</td>
</tr>
<tr>
<td>Aperture</td>
<td>8</td>
</tr>
<tr>
<td>Auto adjustment mode</td>
<td>21</td>
</tr>
<tr>
<td>Auto Focus</td>
<td>7</td>
</tr>
<tr>
<td>Auto Review</td>
<td>67</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W</td>
<td>46</td>
</tr>
<tr>
<td>Battery charger</td>
<td>125</td>
</tr>
<tr>
<td>Battery pack</td>
<td>124</td>
</tr>
<tr>
<td>Beach mode</td>
<td>29</td>
</tr>
<tr>
<td>Beep</td>
<td>74</td>
</tr>
<tr>
<td>Blur</td>
<td>7</td>
</tr>
<tr>
<td>Bracket Step</td>
<td>52</td>
</tr>
<tr>
<td>Burst</td>
<td>50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable for multi-use terminal</td>
<td>78, 84, 100</td>
</tr>
<tr>
<td>Calibration</td>
<td>77</td>
</tr>
<tr>
<td>Camera 1</td>
<td>64</td>
</tr>
<tr>
<td>Camera 2</td>
<td>67</td>
</tr>
<tr>
<td>Center AF</td>
<td>33</td>
</tr>
<tr>
<td>Center-weighted metering</td>
<td>47</td>
</tr>
<tr>
<td>Change REC. Folder</td>
<td>70</td>
</tr>
<tr>
<td>Check Album</td>
<td>72</td>
</tr>
<tr>
<td>Clock Set</td>
<td>76</td>
</tr>
<tr>
<td>Cloudy</td>
<td>47</td>
</tr>
<tr>
<td>Color</td>
<td>9, 42</td>
</tr>
<tr>
<td>Color Mode</td>
<td>46</td>
</tr>
<tr>
<td>Compression ratio</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>107, 114</td>
</tr>
<tr>
<td>Daylight</td>
<td>47</td>
</tr>
<tr>
<td>DC IN jack</td>
<td>12</td>
</tr>
<tr>
<td>Delete</td>
<td>26</td>
</tr>
<tr>
<td>Format</td>
<td>68, 69</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>64</td>
</tr>
<tr>
<td>DirectX</td>
<td>81</td>
</tr>
<tr>
<td>Divide</td>
<td>58</td>
</tr>
<tr>
<td>Download Music</td>
<td>73</td>
</tr>
<tr>
<td>DPOF</td>
<td>103</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronic transformer</td>
<td>121</td>
</tr>
<tr>
<td>EV</td>
<td>31</td>
</tr>
<tr>
<td>Exposure</td>
<td>8</td>
</tr>
<tr>
<td>Exposure Bracket</td>
<td>50</td>
</tr>
<tr>
<td>Extension</td>
<td>88, 90</td>
</tr>
<tr>
<td>Computer</td>
<td>80</td>
</tr>
<tr>
<td>Copying images</td>
<td>83, 96</td>
</tr>
<tr>
<td>Macintosh</td>
<td>96</td>
</tr>
<tr>
<td>Recommended environment</td>
<td>81, 96</td>
</tr>
<tr>
<td>Software</td>
<td>82, 91, 95</td>
</tr>
<tr>
<td>Viewing image files stored on a computer</td>
<td>90</td>
</tr>
<tr>
<td>Windows</td>
<td>80</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>F value</td>
<td>8</td>
</tr>
<tr>
<td>File name</td>
<td>88</td>
</tr>
<tr>
<td>File Number</td>
<td>75</td>
</tr>
<tr>
<td>File storage destination</td>
<td>88</td>
</tr>
<tr>
<td>Fine</td>
<td>49</td>
</tr>
<tr>
<td>Fireworks mode</td>
<td>29</td>
</tr>
<tr>
<td>Flash</td>
<td>48</td>
</tr>
<tr>
<td>Flash Level</td>
<td>52</td>
</tr>
<tr>
<td>Flash mode</td>
<td>23</td>
</tr>
<tr>
<td>Flexible Spot AF</td>
<td>33</td>
</tr>
<tr>
<td>Fluorescent</td>
<td>48</td>
</tr>
<tr>
<td>Focus</td>
<td>7, 32</td>
</tr>
<tr>
<td>Focus preset</td>
<td>33</td>
</tr>
<tr>
<td>Folder</td>
<td>54</td>
</tr>
<tr>
<td>Changing</td>
<td>70</td>
</tr>
<tr>
<td>Creating</td>
<td>69</td>
</tr>
<tr>
<td>Forcedflash</td>
<td>23</td>
</tr>
<tr>
<td>Format</td>
<td>68, 69, 72</td>
</tr>
<tr>
<td>Format Music</td>
<td>73</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>High Sensitivity mode</td>
<td>29</td>
</tr>
<tr>
<td>Histogram</td>
<td>17, 32</td>
</tr>
<tr>
<td>Holding the camera</td>
<td>7, 21</td>
</tr>
<tr>
<td>Housing</td>
<td>77</td>
</tr>
</tbody>
</table>
Index

I
Identifying parts 11
Image file storage destinations and file names 88
Image quality 10, 49
Image size 10, 25
Incandescent 48
Index mode printing 99
Index screen 27
Indicator 13
Initialize 74
Install 82
Internal Memory 18, 68
Interval 52
ISO 8, 9, 49

J
JPG 89

L
Landscape mode 29
Language 74
LCD Backlight 74
LCD Screen 17

M
M AF 64
Macintosh computer 96
  Recommended environment 96
Macro 24
Manual exposure 30
Manual exposure shooting mode 28
Mass Storage 75
Memory Stick 69
“Memory Stick Duo” 122
  Write-protect switch 122
Menu 43
  Items 21, 44
Shooting 46
Viewing 54
Metering Mode 47
Mode 50
Monitor 64
MPG 89
Multi AF 33
Multi Burst 50
Multi connector 12
Multi-pattern metering 47
Multipoint AF 33
Music 73
Music Transfer 95, 97

N
Natural 46
No Flash 23
NR slow shutter 13, 31
NTSC 76

O
On-screen key button 19
Optical zoom 22, 64
OS 81, 96
Overexposure 8

P
P.Quality 49
Paint 41
Paint pen 41
PAL 76
PC 80
PictBridge 75, 99
Picture Motion Browser 91
Pixel 10
Playback 26
Playback zoom 27
Playback/Edit 28
Precision digital zoom 64
Pressing halfway down 7
Print 98
  Index mode 99
  Single-image mode 99
Print order mark 103
Printing at a shop 103
Printing directly 99
Program auto shooting mode 28
Protect 55
PTP 75

R
REC Mode 50
Red Eye Reduction 65
Resize 57
Rewind/Fast forward 26
Rotate 57

S
S AF 64
Scene selection 29
Screen
  Changing the display 17
  Indicator 13
  LCD Backlight 17, 74
Self-diagnosis display 117
Self-timer 23
Sepia 46
Setup 53, 60, 62
  Album 72
  Camera 1 64
  Camera 2 67
  Internal Memory 68
  Memory Stick 69
  Setup 1 73
  Setup 2 74
  Setup 3 75
  Setup 4 77
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/